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PREFACEPREFACE

The computer has become an integral part of our society. It has influenced almost 
every aspect of our lives; be it work or leisure. It is only through computers that we 
are able to organise and execute even the simplest of tasks. 

Snapshot is a series of five books for classes 1 to 5, which brings together ‘knowledge’ 
as well as ‘knowledge application’. Each book is based on Windows 10 and MS 
Office 2016. The books are integrated with National Curriculum Framework (NCF) 
2022.

In classes 1 and 2, students will gain basic knowledge of computer and its devices. 
They will also get to implement their creativity in Tux Paint and MS Paint. 

In classes 3, 4 and 5, students will enhance their skills by gaining knowledge about 
MS Word, MS Excel, MS PowerPoint, LOGO, Scratch, E-mail, Internet, Artificial 
Intelligence and Logical Reasoning.

Through this book, we want to promote modern ways of teaching in which the 
student gets to comprehend and implement knowledge as well as technical 
skills. Rather than restricting the inflow of knowledge to verbal teaching, we have 
included all kinds of activities to further add to the independence of students so 
that they can learn better.

Each chapter is introduced in a systematic manner. The illustrations, application 
screenshots, activities and exercises are curated in simple language to assist the 
teaching-learning process.

—Author

Computer Book_G04_FM.indd   3Computer Book_G04_FM.indd   3 27-02-2023   10:54:4427-02-2023   10:54:44



PLAY-BASED LEARNING Inclusion of word puzzles such as word search, 
crosswords, word jumbles

ETHICS and VALUES Ethics and values like empathy, respect for others, 
equality, and justice

SOCIAL and EMOTIONAL 
LEARNING (SEL)

Self-awareness, Self-management, Decision-making, 
Social awareness, Relationship skills

COMMUNICATION Exchange of information, thoughts, and ideas

EXPERIENTIAL 
LEARNING Hands-on approach, learning through experience

CREATIVITY Imagination, organization, problem-solving,  
innovation

TECHNOLOGY and 
EDUCATION

Extensive use of technology in teaching and  
learning

CRITICAL THINKING Application of logic and reasoning in  
decision-making

Integrated with NCF 2022

DIGITAL AID

EL

PL

EV

SEL

CM

CR

TE

CT

Student’s Assist Teacher’s Assist

Audio and Video eBook
◊	 Features of a computer

	Student Worksheets

Test Paper Generator
◊	 Random and Manual Question Paper
◊	 Download papers in Word format

	 Lesson Plans

	Worksheets

	 Answer Key
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Salient Features

Chapter

7Chapter	1	I	Computer—A	Wonderful	Machine

1

LEARNING OBJECTIVES

In this chapter, students will learn about:
Natural	and	man-made	things
What	are	machines?
Computer—A	wonderful	machine
Why	is	computer	a	unique	machine?

SIGN IN

Colour the pictures.

Look at the two pictures you have coloured. Are they same?  
If not, then how are they different?

Yes,	they	are	different.	A	house	is	made	by	man	and	a	tree	is	a	natural	
thing.	In	this	chapter,	let	us	learn	about	natural	and	man-made	things.

 Computer—A Wonderful Machine

Scan QR Code to
watch a video
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Learning Objectives  
(Lesson Outline)

Activity Time  
(Creative Learning)

News Feed  
(Additional Information)

Sign In  
(Link to the Concept)

Refresh  
(Summary of the Lesson)

Let’s Explore  
(Practical Implementation)

37Chapter 4 I The Keyboard

Make the buttons of a keyboard

How to make—
• Take a chart paper. 
• Cut it into square pieces. (Ask your teacher or an adult for help.)
• Write one letter (A to Z) or number (1 to 10) on each piece. 

These are the buttons of your keyboard.
• Now, take another chart paper and paste the letters of your 

name and number of your birth date.

Name: 

Birth date (Birthday):

ACTIVITY TIME

• A keyboard is used to type on a computer.
• There are many keys on a keyboard.
• Alphabet keys are used to type letters.
• Number keys are used to type numbers.
• Some of the special keys are Arrow keys, Enter key, Spacebar 

key, Backspace key and Caps Lock key.

REFRESH

• Spacebar is the only key with nothing written on it on the keyboard.

NEWS FEED
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15Chapter	1	I	Computer—A	Wonderful	Machine

	 4. 	 It	is	used	to	talk	with	other	people.

     

	 5. 	 It	is	a	machine	with	colourful	beads.

     

a. b. c.

a. b. c.

•	 Roam	around	in	various	places	at	your	school.	Find	out	different	
types	of	machines	in	your	school.

LET'S EXPLORE

•	 Show	the	students	different	types	of	machines	such	as	mobile,	
refrigerator,	water	cooler,	air	conditioner,	vehicles,	etc.	which	can	
be	found	in	school.

•	 Also,	take	the	students	to	the	computer	lab	and	show	them	a	
computer	and	its	various	parts.	Explain	some	of	the	things	that	we	
can	do	using	a	computer.

FOR THE TEACHER
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91Periodic Assessment–4

PERIODIC ASSESSMENT 4
A. Identify the shapes and write their names.

	  	   		 	 	 		 	  

  1.    2. 

	 	          

  3.    4. 

B. With the help of the clues complete the words in the puzzle.

 Across →
2. It is a repeating arrangement.
4. It is the ability to learn.
5. Toy AI

Down ↓
1. It is a puzzle.
3. Voice AI

1 W

2 P

3 A
4 I E

5 A
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93Chapter 9 I Introduction to Artificial Intelligence

A. Draw the following in Tux Paint.

PROJECTPROJECT

B. Draw the following in MS Paint.
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92 Test Paper–2

TEST PAPER 2TEST PAPER 2

A. Tick (ü) the correct option.

  1. It is a natural thing.

   a.   b.    c. 

  2. It is a tool of Paint.

   a.   b.   c. 

B.  Write True (T) for the correct statements and False (F) for  
the incorrect statements.

 1. Tux Paint has a variety of drawing tools.  

 2. Brushes tool is used to draw freehand in Paint.  

 3. A triangle has two sides.  

 4. A tree is a natural thing.  

 5.  Artificial Intelligence refers to the ability  
of the machine to think and learn. 

C. Answer the following questions.

 1. Name two programs that you can use to draw on a computer.

 2. Which tool is used to draw a circle in Paint?

 3. How can we make a pattern?

 4. Write the names of four tools used in Tux Paint.

 5. Define man-made things? Give two examples.
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94 Chapter 9 I Introduction to Artificial Intelligence

(Sample Paper)

LOGICAL REASONINGLOGICAL REASONING

1. Tick the correct option to complete the pattern.

 
18

 
15

 
12

 
9

 
?

  a. 10   b. 8     c. 7    d. 6 

2. Select the odd one out.

  a. 8–4  b. 9–5   c. 7–6   d. 6–2

3. Which of the following is the smallest?

  a.         b.  

  c.    d.  

NATIONAL CYBER OLYMPIADNATIONAL CYBERNATIONAL CYBER  OLYMPIADOLYMPIAD
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Periodic Assessments  
(Revision of Lessons) Test Papers 

(Evaluation of 
Knowledge)

Project  
(Application of 

Knowledge)

National Cyber 
Olympiad  

(Preparation for  
Cyber Competition)
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Chapter

7Chapter 1 I Computers—Memory and  Storage Devices

Computers—Memory and  
Storage Devices1

LEARNING OBJECTIVES

In this chapter, students will learn about:

Data and information

Memory

Measuring memory

Types of memory

Storage devices

SIGN IN

Identify the pictures. Write the name of one item that you can store in each of 
them.
	 Name	 Item that can be stored

a. 	 		 	

b. 	 		  	

c. 	 		  	

d. 	 	 	

Scan QR Code to
watch a video

CMCT
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8 Chapter 1 I Computers—Memory and  Storage Devices

NEWS FEED
We remember what we have learnt about computers in the previous classes. We recall, 
retrieve and use this information when we need it. This information is stored in our brain 
as memory. We store whatever we experience in our memory. For example, we remember 
what we ate for breakfast today. This is because the information about what we ate is 
stored in our brain as memory. 

Similarly, the computer also stores whatever instructions we put in its memory. Let us learn 
about computer memory in this chapter.

DATA AND INFORMATION
Data is a collection of facts such as letters, numbers, images, etc. A single letter of the 
alphabet can also be data. Data is unorganised and incomplete. Data is processed by 
the CPU and after processing it is organised, complete and becomes meaningful. This 
processed data is called information. Information is a group of data that is organised and 
has a specific meaning. 

Let us look at an example to help us understand what are data and information.

Suppose you are hungry and there are only raw vegetables. But how will you eat these 
raw vegetables? We need to cook these vegetables so that we can eat them. Here, the raw 
vegetables are the data and the food cooked from these raw vegetables is the information. 
The raw vegetables become something that we can eat after processing, that is, cooking. 

MEMORY
The memory of a computer is the storage space in the computer. It is used to store data, 
instructions and information. 

MEASURING MEMORY
Memory unit is the amount  of data and information that can be stored in a storage device. 
The basic unit for measuring the memory of a computer is byte. A byte is equal to eight bits. 
Computer memory is also measured in Kilobyte, megabyte, gigabyte, terabyte and so on. 

Let us look at different memory sizes.

8 Bits	 =	 1 Byte

1024 Bytes	 =	 1 Kilobyte (KB)

1024 Kilobytes (KB)	 =	 1 Megabyte (MB)

1024 Megabytes (MB)	 =	 1 Gigabyte (GB)

1024 Gigabytes (GB) 	 =	 1 Terabyte (TB)

1024 Terabytes (TB)	 =	 1 Petabyte (PB)

1024 Petabytes (PB)	 =	 1 Exabyte (EB)

1024 Exabytes (EB)	 =	 1 Zettabyte (ZB)

1024 Zettabytes (ZB)	 =	 1 Yottabyte (YB)
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9Chapter 1 I Computers—Memory and  Storage Devices

TYPES OF MEMORY
Computer memory is of two types:

•	 Primary Memory
•	 Secondary Memory

Primary memory 
Primary Memory is also called Internal or Main Memory. It is a memory that is already 
there in the computer and is directly accessed by the CPU. It stores the instructions and 
data we put on the computer while it is powered. Once the computer is switched OFF, the 
data stored in the memory will be erased. 

Primary memory is of two types:

•	 Random Access Memory (RAM)
•	 Read Only Memory (ROM)

Random Access Memory (RAM)
It is a temporary memory. It stores all the data and 
instructions temporarily. RAM is also called Volatile 
Memory. This is because the information in this 
memory is deleted when the computer is switched OFF. 

Read Only Memory (ROM)
ROM is a permanent memory. The data and 
information stored in this memory will not be erased 
even if the computer is switched OFF. ROM is also 
called Non-Volatile Memory. 

Secondary Memory 
Secondary memory is permanent and it is not directly accessed by the CPU. This type of 
memory is stored in secondary memory devices. These devices are also called secondary 
storage devices. They are categorised into three types:

•	 Magnetic Disk
•	 Optical Disc
•	 Flash Drive

The term byte was coined by Werner Buchholz in June 1956. 

NEWS FEED

RAM

ROM

CM
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10 Chapter 1 I Computers—Memory and  Storage Devices

STORAGE DEVICES 
We need storage space to store our things such as cupboards for our clothes. Similarly, 
computers also need a storage device to store a large amount of data and instructions. 
As mentioned above, storage devices can be divided into three categories—magnetic disc, 
optical disc, and flash drive. 

Magnetic Disk
It is a device that is covered with a magnetic coating. You can store and erase data in a 
magnetic disk any number of times. 

Hard Disk
•	 The hard disk has one or more magnetic disks which 

are known as Platters. It is permanently fixed inside 
a CPU box. It is used to store a large amount of data 
and programs. 

•	 Hard disks are available in different storage 
capacities. 

•	 External hard disks are also available which can 
be used to store data. These are external storage 
devices and are connected to a computer through a 
USB port. 

An external hard disk connected to a laptop

Hard Disk

Punch Cards were the earliest recorded digital storage device. 

NEWS FEED
CM
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11Chapter 1 I Computers—Memory and  Storage Devices

Optical Disc
An optical disc is an electronic data storage medium that uses optical technology and 
techniques to read and write data.

CD
The full form of the CD is Compact Disc. A CD can store up to 700 
Megabytes (MB) of data. A CD is used to store and view audio, video, and 
other data. It is an external storage device and a CD drive is required to 
read the information stored in it. 

DVD
DVD stands for Digital Versatile Disc. A disk can hold more data than a 
CD. The storage capacity of DVDs ranges from 4.7 GB to 17 GB. A DVD is 
mostly used for storing and viewing data. 

Blu-Ray Disc
The storage capacity of a Blu-Ray disc is up to 128 GB. It is mainly used to 
hold high-quality images, sounds, and videos. The storage capacity of a 
Blu-Ray Disc is higher than that of a DVD. 

Flash Drive
It is a small portable storage device that has a USB (Universal Serial Bus) 
connector. Pen Drive and Memory card are examples of flash drives. 

Pen Drive
It is a small hard drive and can be plugged into a computer 
with a USB drive. A pen drive can store up to 1 Terabyte (TB) of 
data. It is often used for transferring data from one computer to 
another. 

Memory Card
It is a storage device for mobile phones, cameras, etc. It is mainly used for storing and 
transferring data. A memory card is very small in size and a card reader is required to read 
the data stored on it. 

CD

DVD

Blu-Ray Disk

Pen Drive

A memory card in a card slotMemory card
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12 Chapter 1 I Computers—Memory and  Storage Devices

•	 The computer stores whatever instructions we put in its memory. 
•	 Data is a collection of facts such as letters, numbers, images, etc.
•	 Information is a group of data that is organised and has a specific meaning. 
•	 The memory of a computer is the storage space in the computer. 
•	 The basic unit for measuring the memory of a computer is byte.
•	 Computer memory is of two types—Primary and Secondary.
•	 Storage devices can be divided into three categories—Magnetic disc, Optical disc, 

and Flash drive.

REFRESH

Identify the storage devices.

ACTIVITY TIME

1. 	 2. 	 	 3. 	

4. 	 5. 	 	 6. 	

A 	 Choose the correct option.

	 1. 	� RAM stands for  .

		  a.   Random Access Memory 	 b.   Random Align Memory 

		  c.   Random Aside Memory 

BROWSE

CM
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13Chapter 1 I Computers—Memory and  Storage Devices

	 2. 	� The Secondary Memory is categorised into  .

		  a.   four types	 	 b.   two types	 	 c.   three types�

	 3. 	  is a magnetic disk.

		  a.   Hard Disk	 	 b.   Compact Disc	 	 c.   Digital Versatile Disc�

	 4. 	� The storage capacity of a Blu-ray disc is up to  .

		  a.   120 GB	 	 b.   128 GB	 	 c.   115 GB�

	 5. 	� 1 GB has  .

		  a.   1024 MB	 	 b.   1024 GB	 	 c.   1024 TB�

B 	 Fill in the blanks with the words given below.

	 Read      memory      eight      platters      store

	 1. 	� A byte is equal to  bits.

	 2. 	� The full form of ROM is  Only Memory.

	 3. 	� The hard disk has one or more magnetic disks known as  .

	 4. 	� A CD is used to  and view audio, video, and other data .

	 5. 	� A  card is a storage device for mobile phones,  

cameras, etc .

C 	 Write T for True Statements and F for False Statements. 

	 1. 	� ROM stands for Read Only Memory.�

	 2. 	� Hard Disk is an internal storage device.�

	 3. 	� The storage capacity of a Blu-Ray Disc is not higher than that of a DVD.�

	 4. 	� DVD stands for Digital Versatile Disc.�

	 5. 	� You cannot store and erase data in a magnetic disk.�
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14 Chapter 1 I Computers—Memory and  Storage Devices

D 	 Answer the following questions in one word or two words.

	 1. 	� How many gigabytes make 1 terabyte?

		

	 2. 	� What is the other name for primary memory?

		

	 3. 	� Write one example of data.

		

	 4. 	� What is the basic unit for measuring the memory of a computer?

		

	 5. 	� Who coined the term byte?

		

	 6. 	� Write an example of a secondary storage device.

		

E 	 Answer the following questions.

	 1. 	� Differentiate between primary memory and secondary memory?

	 2. 	� What is the difference between RAM and ROM?

	 3. 	� What is a memory card?

	 4. 	� What is a storage device? Give two examples.

	 5. 	� What is an optical device? Explain its three types. 
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15Chapter 1 I Computers—Memory and  Storage Devices

Match the following.

1. 	�  	 a. 	 Primary memory

2. 	�  	 b. 	 Storage device for mobile phones and cameras

3. 	�  	 c. 	 Storage capacity range from 4.7 GB to 17 GB

4. 	�  	 d. 	 Storage capacity of up to 700 Megabytes

5. 	 �	 e. 	 Storage capacity up to 1 TB 

ACTIVITY TIME

•	 Go to your computer lab and make a list of storage devices used to store data. 
•	 On a chart paper, paste pictures of five storage devices and write their functions and 

storage capacities.

LET'S EXPLORE

•	 Explain the concept of memory.
•	 Explain the relationship between different measuring units of computer memory.
•	 Show them the different storage devices.

FOR THE TEACHER

CMCT

EL CRTE
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16 Chapter 2 I More on Windows 10

More on Windows 102

LEARNING OBJECTIVES

In this chapter, students will learn about:

Windows 10—Desktop

Start menu

This PC icon

Taskbar

Managing files and folders

SIGN IN

Identify and circle the icons you see on the computer screen. Say the name of 
any two.

Scan QR Code to
watch a video

CMCT
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17Chapter 2 I More on Windows 10

An operating system makes sure that the computer system is working smoothly. Windows 
is an operating system based on GUI (Graphical User Interface) provided by Microsoft. 
It has many versions such as Windows XP, Windows 7 and Windows 10. Windows 10 is the 
most popular version. Let us learn about Windows 10.

WINDOWS 10—DESKTOP 
When we turn on a computer, it starts booting, and the Windows 10 welcome screen 
appears. After some time, the desktop will appear which is the final screen. It is the main 
interface between the user and the computer. A desktop has many components such as 
the Start menu, Taskbar, Background and Icons. 

Windows 10 is running in 192 countries–that is almost every country on Earth.

NEWS FEED

Start Menu
Start menu is the location in Windows to find installed programs, files or folders. We can 
open the Start menu by clicking on the Start button . The Start menu has two panes. 
The left pane shows an alphabetical list of all the programs installed on the computer. The 
right pane contains tiles.

Start Button

Icons

Desktop Background

Taskbar

CM

Computer G4_Ch-2.indd   17Computer G4_Ch-2.indd   17 23-02-2023   13:55:0023-02-2023   13:55:00



18 Chapter 2 I More on Windows 10

Live Tiles
Live tiles are the shortcuts of applications 
found in a grid on the right pane. Information 
such as news, emails and weather are 
displayed on these titles. These tiles also 
display some games. We can make, resize,  
add or remove these tiles.

Resizing a Tile
Resizing a tile means changing the size of tiles. 
We can choose small, medium, wide or large 
size depending on the application. 

Follow these steps to resize a tile:

1.	 Click on the Start button.
2.	 Select the tile you want to resize and right-click on it.
3.	 Select the resize option.
4.	 Select the size. The tile will be resized.

1

2
3

4

Adding a Tile
We can add more tiles to the existing tiles.

Follow these steps to add a tile:

1.	 Click on the Start button
2.	 Scroll to the name of the application or program.  

Right-click on the app you want to add to the  
Start menu. 

3.	 Click on Pin to Start. The selected app will appear  
on the tile.

Live  
Tiles

Left pane Right pane

2

1

3
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19Chapter 2 I More on Windows 10

Removing a Tile
We can remove the tile of an app. 

Follow these steps to remove a tile: 

1.	 Right-click on the tile you want to remove.
2.	 Click on Unpin from Start. The tile will be removed. 

ICONS
Icons are the small images or symbols that appear 
on the desktop. They represent programs, files and 
folders. They are the shortcut of the programs installed 
on the computer such as This PC and Recycle Bin. We can click on these icons to open the 
programs. 

This PC Icon
Clicking on This PC icon opens a window that shows all the files and folders 
saved on the computer. This window is also known as File Explorer. In 
this window, we can create, delete, rename, copy, move, or search files or 
folders. 

File Explorer window

Recycle Bin
We can find all the deleted folders and files in the Recycle Bin. If a file is 
deleted by mistake, we can restore it to its original place.

To open the Recycle Bin window, double-click on the Recycle Bin icon 
on the desktop. The items in this folder can be permanently deleted or 
restored to their original places.

Delete Permanently

1.	 To delete all the files and folders permanently, click on the Empty Recycle Bin button.

This PC icon

Recycle Bin icon

2

1
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Restore

2.	 To restore selected files or folders, click on the Restore the selected items button.
3.	 To restore all the files and folders, click on Restore all items.

1

3

2

TASKBAR
Taskbar is the horizontal bar located at the bottom of 
the desktop. It shows all programs opened in different 
windows. It has Start Button and Notification Area. It also 
contains shortcuts to applications that are often used. We 
can change the application we want to add to the Taskbar.

Pin an application to the Taskbar
To pin an application to the Taskbar means to add a 
shortcut to the Taskbar. 

Follow these steps to pin an application to the Taskbar:

1.	 Type and search the name of the application you 
want to pin in the search box. Let’s search for Paint.

2.	 Right-click on the application name in the search 
results. A menu with options appears.

3.	 Click on Pin to the taskbar option. The application 
icon will appear in the Taskbar.

Unpin an application from the Taskbar
To unpin an application to the Taskbar means to remove a 
shortcut from the Taskbar.

Follow these steps to pin an application to the Taskbar:

1.	 Right-click on the application icon on the Taskbar. A 
menu with options appears.

3

2

1

2

1
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2.	 Click on Unpin to the taskbar option. The application icon will be removed from the 
Taskbar.

Moving the Taskbar
The position of the Taskbar can be changed. It can be moved from the bottom of the 
screen and placed on any of the four sides of the screen.

Follow these steps to change the position of the Taskbar:

1.	 Right-click on the Taskbar. A menu of options will appear.
2.	 Uncheck the ‘Lock the taskbar’ by clicking on it.
3.	 Click on the Taskbar and drag it to the side of the screen.

21

3

MANAGING FILES AND FOLDERS 
In the previous class, we have learnt about files and folders. We can make changes to 
existing files and folders such as renaming the file. We can also copy, move, or delete an 
existing file or folder. Let us learn how to make these changes. 

Copy a File or Folder
When we copy a file or folder, we make a copy of the original file or folder. It can be saved 
in the same location or in another location, without moving it from the original location. 

Follow these steps to move a file or a folder to a new location:

Method 1

1.	 Browse the location of the file or folder you want to delete in File Explorer.
2.	 Select the file or the folder to be copied.

3.	 Click on the Copy  command, in the Clipboard group.

4.	 Select the location where you want to move it. 

5.	 Click on the Paste  command, in the Clipboard Group. 
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	 The selected file or folder will appear at the new location.

The copied  
folder appears at 
the new location.

1

2

4

3 5

Method 2

1.	 Browse the location of the file or folder you want to delete in File Explorer.
2.	 Select the file or the folder to be moved.

3.	 Click on the Copy to  command, in the Organize group.

4.	 Select the location where you want to save it. Click on it. The file or the folder will copy 
to the new location. 

The folder 
appears in the 
new location.

3

4
1

2

Move a File or a Folder
A file or a folder saved in one location can be moved to 
another. The file or the folder is removed from the original 
location and placed at the new location when we move it. 

Follow these steps to move a file or a folder to a new location:

Method 1

1.	 Browse the location of the file or folder you want to move 
in File Explorer.

3

2

1
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2.	 Select the file or the folder to be moved.

3.	 Click on the Cut  command, in the 

Clipboard group.
4.	 Select the location where you want to  

move it. 

5.	 Click on the Paste  command, in the 

Clipboard Group. 
The selected file or folder will move to the 
new location.

Method 2

1.	 Browse the location of the file or folder you want to delete in File Explorer.
2.	 Select the file or the folder to be moved.
3.	 Click on the Move to  command, in the Organize group.
4.	 Select the location where you want to move it. The file or the folder will move to the 

new location. 

1
4

2

3

The file is 
moved to the 
new location.

The folder 
moved to the 
new location.

5

4

QUICK BYTE

The Shortcut keys to—

•	 Copy a file/folder: Ctrl + C
•	 Paste a file/folder: Ctrl + V
•	 Cut a file/folder: Ctrl + X

CM
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Delete a File or Folder
We can delete a file or folder saved on the 
computer system. 

Follow these steps to delete a file or folder:

Method 1

1.	 Browse the location of the file or folder you 
want to delete in File Explorer. 

2.	 Select the file or the folder to be deleted.
3.	 Click on the Delete  command, in the 

Organize group. The folder will disappear.

Method 2

1.	 Browse the location of the file or folder you 
want to delete in File Explorer. 

2.	 Right-click on the file or folder you want to 
delete. A list of commands will appear.

3.	 Click on the Delete option. 

Method 1

1 2

3

Method 2

1

2

3

Windows 10 is the first version of Windows with digital personal assistance, Cortana.

NEWS FEED

Write the functions for these keyboard shortcuts.

1. 	 Ctrl + V	

2. 	 Ctrl + X	

3. 	 Ctrl + C	

ACTIVITY TIME

CM

CMCT
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•	 Start menu is the location in Windows to find installed programs, files or folders.
•	 Live tiles are the shortcuts of applications found in a grid on the right pane.
•	 Icons are the small images or symbols that appear on the desktop. 
•	 Taskbar is the horizontal bar located at the bottom of the desktop
•	 We can find all the deleted folders and files in the Recycle Bin. 
•	 We can make changes to existing files and folders such as renaming the file.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	 This is the Start menu button.

		  a.   	 	 b.   	 	 c.   �

	 2. 	 The start menu has .

		  a.   three panes	 	 b.   two panes	 	 c.   four panes�

	 3. 	 To add a tile, we have to click on .

		  a.   Pin to Taskbar	 	 b.   Unpin to Start	 	 c.   Pin to Start�

	 4. 	� Clicking on This PC icon opens a window. This window is known as 

.

		  a.   File Explorer	 	 b.   This PC	 	 c.   File�

	 5. 	 We can find all the deleted files and folders in .

		  a.   This PC	 	 b.   Start menu	 	 c.   Recycle Bin�
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B 	 Fill in the blanks with the words given below. 

	 left    symbols    Empty    Taskbar    tiles

	 1. 	� Icons are  that appear on the desktop.

	 2. 	�   shows all programs opened in different windows.

	 3. 	� The  pane shows an alphabetical list of all pro-

grams installed on the computer. 

	 4. 	� Live  are the shortcuts of applications found in a 

grid on the right pane.

	 5. 	� To delete all the files and folders permanently, click on the 

 Recycle Bin.

C 	 Write T for true statements and F for false statements.

	 1. 	 You can resize a tile from the right pane.�

	 2. 	 You cannot restore the files after deleting them.�

	 3. 	 We can make changes to existing files and folders such as renaming.�

	 4. 	 A file or a folder saved in one location cannot be moved to another.�

	 5. 	 You cannot pin Paint to the Taskbar.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	 What is the location in Windows to find installed programs, files or folders?

		

	 2. 	 Where do you click to open Start menu?
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	 3. 	� What is the shortcut key to copy a file?

		

	 4. 	 What do you call the horizontal bar located at the bottom of the desktop?

		

	 5. 	 Where can you find the notification menu?

		

E 	 Answer the following questions.

	 1. 	� What are live tiles?

	 2. 	� Write the steps to remove a tile.

	 3. 	� What are icons?

	 4. 	� What is a Taskbar? Write the steps to change the position of a Taskbar.

	 5. 	� Write the steps to delete a file or a folder.

Fill in the boxes with the correct sequence (1–4) to resize a tile.

ACTIVITY TIME
CT
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Activity A: Select any of the app that is not pinned on the Taskbar and pin it to the 
Taskbar. 

Activity B: To create a folder and move it to a new location.

•	 First create a new folder and save it with your name on the desktop. 
•	 Now, copy-paste the folder and save it in D: drive.
•	 Then, go back to Desktop and cut-paste the folder you have created and save 

in D: drive.

LET'S EXPLORE

•	 Discuss the various components of the desktop.
•	 Explain the various functions of the icons This PC and File Explorer. 
•	 Explain how to work with tiles.
•	 Explain how to create, rename or delete file or folder. 

FOR THE TEACHER

ELTE
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PERIODIC ASSESSMENT 1 

A.	 Identify the following images and write their names.

	     

	 1.	 	 2.  	 3. 

B.	 Fill in the blanks using the words given below.

RECYCLE BIN        DESKTOP        ICON        BYTE         TWO

	 1.	�   is the basic unit of measuring the computer 
memory.

	 2.	 Deleted files are stored in . 

	 3.	�   is the main interface between the user and 
computer.

	 4.	 Computer memory is categorised into  types.

	 5.	  are the small symbols of programs on the desktop.

C.	 Match the following.
	 1.  1024 bytes		  a.  Hard Disk
	 2.  Right Pane		  b.  ROM
	 3.  Primary Memory		  c.  Ctrl + C
	 4.  Magnetic Disk		  d.  1 Kilobyte
	 5.  Copy a File		  e.  Live Tiles
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Editing Text in MS Word 20163

LEARNING OBJECTIVES

In this chapter, students will learn about:

Selecting text

Copying or Cutting text

Deleting text

Inserting text

Undo and redo

Spelling and Grammar check

SIGN IN

Match the following.

1. 	 Ribbon	 a. 	

2. 	 File Tab	 b. 	

3. 	 Rulers	 c. 	

4. 	 Zoom Slider	 d. 	

5. 	 Status Bar	 e. 	

6. 	 Quick Access Toolbar	 f. 	

Scan QR Code to
watch a video

CT
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MS Word is word processing software that helps us to create and print documents. We can 
also edit existing documents in MS Word. To edit a document means making changes in 
the document. We have already learnt how to create and save a document. In this chapter, 
let us learn how to edit an existing document.

SELECTING TEXT
We can make changes to the existing text. To make the required changes, we need to 
select it. In the picture given below, we can see that a sentence has been selected.

We have learned that we can select text by dragging the cursor over it. Let us learn how 
to select text using shortcuts in MS word 2016. Text can be selected using a keyboard or 
a mouse.

Using a keyboard to select text:

•	 Press  +  to select a letter on the right of the cursor. 

•	 Press  +  to select a letter on the left of the cursor.

•	 Press  +  to select one line up the cursor.

•	 Press  +  to select one line down the cursor.

•	 Press  +  +  to select a word on the right of the cursor. 

•	 Press  +  +  to select a word on the left of the cursor. 

Using a Mouse to select text:
•	 Double-click on a word to select it.
•	 Click on the left margin next to the line to select it.

•	 Click while holding the  key on a sentence to select it.
•	 Click three times on a paragraph to select it.

Selected text
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COPYING OR CUTTING TEXT
We can copy or cut text and paste it in a different place. 

Copying the text means creating a duplicate of the original text. When we copy and paste 
the text, it will remain in the original place and where it is pasted.

Cutting the text means removing the original text. When we cut and paste the text, it will 
be removed from its original place. It will move to the new place.

Follow these steps to copy or cut text:

1.	 Select the text you want to copy.
2.	 Click on the Home tab.
3.	 Click on the Copy button  or Cut button  in the Clipboard group.
4.	 Select the place where you want to copy the selected text.
5.	 Click on the Paste button in the Clipboard group.

1

After copy and paste

Text in both original and new place

2

3

The original name of MS Word was ‘Multi-Tool Word’ but it was shortened to its current 
name ‘Word’ as they felt the name is too long. 

NEWS FEED
CM
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DELETING TEXT
We can easily remove text if we have made a mistake while typing. It can be done using 
the Backspace or the Delete key.

Using Backspace Key

•	 To delete the text to the left of the cursor, press  key.

•	 To delete the word to the left of the cursor, press  +  key.

Using Delete Key

•	 To delete the text to the right of the cursor, press  key.

•	 To delete the word to the right of the cursor, press  +  key.

To delete a group of text, a sentence or a paragraph, select the text and press   
or  key.

INSERTING TEXT 
We can insert text between existing words. To insert the text, place the pointer where the 
text is to be inserted and click. The cursor will appear. Now, type the text and you can see 
the inserted text where the cursor appears. 

QUICK BYTE

The shortcut key to—

Copy text: Ctrl + C Cut text: Ctrl + X Paste text: Ctrl + V

After cut and paste

Text in the  
new place

CM
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UNDO AND REDO 
Undo is used to remove or cancel the previous action. For example, if we mistakenly delete 
a word, we can recover it by using undo action. To undo an action, click on the Undo button  

 on the Quick Access Toolbar. 

Redo is used to reverse the action of Undo command. To undo an action, click on the Redo 
button  on the Quick Access Toolbar. 

Shortcut keys:

To Undo:	 Ctrl + Z

To Redo:	 Ctrl + Y

SPELLING AND GRAMMAR CHECK 
MS Word has a Spelling and Grammar check feature that helps us create error-free 
documents. It highlights if we make any spelling or grammatical mistakes. In MS Word 
2016, spelling mistakes are shown by a red wavy line and grammatical mistakes are 
shown by two blue lines.

When we right-click on words with a red wavy line or two blue lines, a list of suggestions to 
replace the incorrect word appears. Choose and click the correct word on the list. 

Spelling check

Grammar check
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To check spelling and grammar through Spelling and Grammar button, follow these steps:

1.	 Click at the beginning of the document.
2.	 Click on the Review tab on the ribbon.
3.	 Click on Spelling and Grammar in the Proofing group.
	 The first mistake will be selected and displayed with a list of suggested options in the 

side panel.
4.	 Choose and click on the suggestion you want to use for correcting the error. 
	 The word will be replaced with the correct option. 

After the first mistake, it will select the next mistake and display it on the side panel. Choose 
the correct option and click on it. Click Ignore once or Ignore All option to skip errors and 
continue working on the document. 

3

2

41

Highlighting grammatical error

QUICK BYTE

Shortcut key to check Spelling and Grammar: F7

CM
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Word is the most popular word processor.

NEWS FEED

•	 MS Word is word processing software that helps us to create and print documents.
•	 Text can be selected using a keyboard or a mouse.
•	 Copying the text means creating a duplicate of the original text.
•	 Cutting the text means removing the original text.
•	 Undo is used to remove or cancel the previous action.
•	 Redo is used to reverse the action of Undo command.
•	 MS Word has a Spelling and Grammar check feature that helps us create error-free 

documents.

REFRESH

Match the following.

1. 	 	 a.   Cut

2. 	 	 b.   Undo

3. 	�  	 c.   Paste

4. 	 	 d.   Redo

5. 	 	 e.   Copy

ACTIVITY TIME

A 	 Choose the correct option.

	 1. 	 To select one line up the cursor, press  .

		  a.    + 	 	 b.    + 	 	 c.    + �

BROWSE

CM

CT
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	 2. 	 To select a word on the right of the cursor, press .

		  a.    +  + 	 	 b.    +  + �

		  c.    +  + 	

	 3. 	 To select a letter on the left of the cursor, press  .

		  a.    + 	 	 b.    + 	 	 c.    + �

	 4. 	 To delete the text to the left of the cursor, press  key.

		  a.   	 	 b.   	 	 c.   �

	 5. 	 To delete the text to the right of the cursor, press  key.

		  a.   	 	 b.   	 	 c.   �

B 	 Fill in the blanks with the words given below.

	 Undo      Edit      Redo      Cutting      Copying

	 1. 	�   means to make changes in the document.

	 2. 	�   the text means creating a duplicate of the  

original text.

	 3. 	  the text means removing the original text.

	 4. 	  is used to remove or cancel the previous action.

	 5. 	  is used to reverse the action of Undo command.

C 	 Write T for true statements and F for false statements.

	 1. 	� Double-click on a paragraph to select it.�

	 2. 	� Ctrl + V is the shortcut key to copy text.�
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	 3. 	� We use the Backspace key to delete text.�

	 4. 	 We cannot check spelling and grammatical mistakes in MS Word.�

	 5. 	� In MS Word, spelling mistakes are shown by a red wavy line.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	 How do you select a line using a mouse?

		

	 2. 	 How do you select a word using a mouse?

		

	 3. 	 What is the shortcut key to Redo?

		

	 4. 	 What is the shortcut key to Undo?

		

	 5. 	 What is the shortcut key to check Spelling and Grammar?

		

E 	 Answer the following questions.

	 1. 	 What is the difference between copying and cutting text?

	 2. 	 Write the steps to delete text using the Delete key.

	 3. 	 How do you insert text between two existing words?

	 4. 	 What is the difference between Redo and Undo?

	 5. 	� What is the Spelling and Grammar check feature in MS Word? How are they 
shown in a document?
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ACTIVITY TIME

Arrange the commands in the correct group.

1. 	� Undo

2. 	� Spelling check 

3. 	� Paste

4. 	� Redo

5. 	� Grammar check

6. 	� Cut

7. 	� Copy

QUICK ACCESS 
TOOLBAR

PROOFING CLIPBOARD

•	 In the lab, open MS word and type ‘Shortcut Keys’ and operate all the shortcut keys 
mentioned in this chapter

•	 Now, on a chart paper, create a poster of all the shortcut keys and their functions. 
Refer to the image given below. 

LET'S EXPLORE

•	 Explain what editing a document means.
•	 Show the students how to edit a document using the editing features in MS Word 

discussed in the chapter.
•	 Ask the students to edit a document.

FOR THE TEACHER

CM CRCT

EL TE
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Formatting Text in MS Word 20164

LEARNING OBJECTIVES

In this chapter, students will learn about:

Changing Font Style

Changing Font Size

Changing Font Colour 

Changing Font Case

Highlighting Text

Applying Bold, Italic and Underline 

Applying Text Effects

Changing Text Alignment

Applying borders

Applying Shading

Bullets and Numbering

SIGN IN

Design your school timetable.  
Fill in the table using the given 
colour code:
Name of the days—Blue; Maths—
Green, Hindi—Pink, English—Purple, 
Computer—Yellow, Social Science—
Red and Science—Orange. You can 
add other subjects and the number 
of periods if required.

8.00 - 8.55 9.00 - 9.55 10.00 - 10.55 11.00 -11.55 13.00 - 13.55 14.00 - 14.55

W e d n e s d a y

T h u r s d a y

T u e s d a y

F r i d a y

M o n d a y

S C H O O L  T I M E TA B L E

N O T E

Scan QR Code to
watch a video

CM CR
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We have learnt how to edit a document in MS Word 2016. We can also change the look 
of the text in MS Word. Changing the appearance of the text to make it attractive is 
called formatting of the text. We can do the formatting by changing font style and size, 
highlighting words, changing font colour, etc. Formatting can be done using the Font group 
and Paragraph group which are contained in the Home tab.

Let us learn about the formatting text in detail.

CHANGING FONT STYLE
Font is the characteristic of a specific style and size used for typing the 
text. When we open a new blank MS Word document, the default font 
style and size are already in place. The default font is Calibri and the font 
size is 11 point. These can be changed according to the requirement. 

Follow these steps to change the font style of the text:

1.	 Select the text to be formatted.
2.	 Click on the Home tab.
3.	 Click on the drop-down arrow to the right of the Font box 

 in the Font group. A list of all the fonts appears.
4.	 Choose and click on the required font. The font will be changed.

1

4

3
2

The small window that appears on selecting the text has all the basic formatting 
command buttons.

NEWS FEED
CM
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CHANGING FONT SIZE
Follow these steps to change the font size of the text:

1.	 Select the text to be formatted.
2.	 Click on the Home tab.
3.	 Click on the drop-down arrow to the right of the Font size box  in the Font group. 

A list of all the font sizes appears. 
4.	 Choose and click on the required font size. The font size will be changed.

3

2 4

1

CHANGING FONT COLOUR
Follow these steps to change the font colour of the text:

1.	 Select the text to change the font colour.
2.	 Click on the Home tab.
3.	 Click on the drop-down arrow to the right of the Font color 

box  in the Font group. A colour palette appears. 
4.	 Choose and click on the colour you want to change the text. 

The font colour will be changed.

Colour Palette
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CHANGING FONT CASE
In MS Word, we can change the text to uppercase, lowercase or other common 
capitalization. Word 2016 offers five case options. 

Follow these steps to change the case of the selected text:

•	 Select the text to be formatted.
•	 Click on the Home tab.
•	 Choose the required option from the following list and—
•	 Click on Sentence case to capitalize only the first letter of a 

sentence.
•	 Click on lowercase to set all the letters as lowercase.
•	 Click on UPPERCASE to capitalize all the letters.
•	 Click on Capitalize Each Word to capitalize the first letter of each word. 
•	 Click on tOGGLE cASE to shift between Capitalize Each Word and the opposite. 

(Capitalize Each Word—cAPITALIZE eACH wORD)

HIGHLIGHTING TEXT
The important text in a document can be highlighted. Highlighting text means placing a 
coloured rectangle over it. The background colour of the selected text changes when we 
highlight them.

Follow these steps to highlight the selected text:

1.	 Select the text to be highlighted.
2.	 Click on the Home tab.
3.	 Click on the drop-down arrow to the right of the Text Highlight Color  button in 

the Font group. A colour palette appears.
4.	 Choose and click on the colour you want to use.

1

2

3

4

Options offered by 
Word
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APPLYING BOLD, ITALIC AND UNDERLINE
To make the text Bold means to make the text darker than the rest of the text.

•	 To make text italicised means to make it slanted to the right.
•	 To underline text means to put a line under it. 

Follow these steps to format the selected text:

1.	 Select the text to be highlighted.
2.	 Click on the Home tab.
3.	 Choose the required option from the following list—

•	 Click on  button in the Font group to make the selected text bold.
•	 Click on  button in the Font group to make the selected text italics.
•	 Click on  button in the Font group to underline the selected text.

QUICK BYTE

The shortcut key to—

•	 make the text bold: Ctrl+B
•	 make the text italicized: Ctrl+I
•	 underline the text: Ctrl+U

APPLYING TEXT EFFECTS
Some of the text effects that can be applied to the text 
include making the text as blurred, outlining the text, 
changing font colour and style and shadowing the text. 

Follow these steps to apply text effect:

1.	 Select the text for which text effects are to  
be added. 

2.	 Click on the Home tab.
3.	 Click on the Text Effects button in the Font group. 

The available effects will appear.
4.	 From the effects, choose and click on the  

effect you want to apply.

Text effects 

CM
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4

1

2 3

CHANGING TEXT ALIGNMENT
Alignment refers to how the text is set with respect to the margins in a document. MS Word 
has four alignment options—left, centre, right and justify. The default setting in MS Word is 
left-align. We can change this alignment to any of the given options.

Align Text Left

Centre Align Text Right

Justify

Follow these steps to change the alignment:

1.	 Select the text.
2.	 Click on the Home tab. 
3.	 Choose and click on one of the alignment options in the paragraph group. 

•	 Click on Align Text Left  button to set the text towards the left margin.
•	 Click on Centre  button to set the text in the centre of the left and right margins.
•	 Click on Align Text Right  button to set the text towards the right margin.
•	 Click on Justify  button to set the text evenly between the left and the right 

margins.

Applying Align Text Left

Applying Align Text Right

Applying Centre alignment

Applying Justify alignment
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QUICK BYTE

The Shortcut key to— 

•	 align text Left: Ctrl + L
•	 Centre align: Ctrl + E

•	 align text Right: Ctrl + R
•	 Justify align: Ctrl + J

APPLYING BORDERS
We can make a document attractive by adding a border to a set of text or the whole page. 
Borders can be a set of lines, shapes, boundaries or graphics. 

Follow these steps to apply a border to the selected text:

1.	 Select the text.
2.	 Click on the Home tab.
3.	 Click on the Borders option in the paragraph group.
4.	 Select Borders and Shading from the list box. Borders and Shading dialog box will 

appear. 
5.	 Click on the Borders tab in the dialogue box. 
6.	 Choose a border style and colour and click on the OK button. 

1

2 3

4

5 6

CM
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We can also apply artistic border to a page.

Follow these steps to apply artistic border:

1.	 Click on the Page Border tab in 
the Borders and Shading dialog 
box.

2.	 Click on the drop-down arrow of 
the Art section. You can see the 
Art section box below the Color 
box. 

3.	 Choose and click on the border 
style.

1

2

3

We can also create a custom border in MS Word using clip art, a picture file,  
a scanned photograph, or a picture created in a drawing program. 

NEWS FEED

APPLYING SHADING
Shading is applied to make the text 
attractive. 

Follow these steps to apply shading:

1.	 Select the text. 
2.	 Click on the Home tab.
3.	 Click on the Shading option in the 

paragraph group.
4.	 Choose a colour.

BULLETS AND NUMBERING 
We can format a list in a document by using bullets and 
numbers. 

A bullet is a small symbol such as a dot, tick, or square 
used to list items. 

Follow these steps to use bullets:

1.	 Click on the Home tab.

1

2 3 4

CM
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2.	 Click on the drop-down arrow next to the Bullets 
 in the Paragraph group.

3.	 Select and click the bullet style you want to use from 
the Bullet Library.

4.	 Type the first item of the list next to the bullet.  
Then, press the Enter key. The next bullet will 
appear below it. 
To finish the list, press the Enter key twice.

Follow these steps to apply numbering:

1.	 Click on the Home tab.
2.	 Click on the drop-down arrow next to the  

numbering  in the Paragraph group.
3.	 Select and click the numbering style you want to use 

from the Numbering Library.
4.	 Type the first item of the list next to the numbering. 
5.	 Then, press the Enter key. The next number will 

appear below it.
6.	 To finish the list, press the Enter key twice.

Unscramble the words.

1.   MAGTINNIE	 	 2.   FOIGNARMTT	

3.   LDBO	 	 4.   ACTLII	

5.   FTUSJIY	 	 6.   BTLUSEL	

7.   RUGBNMENI	 	 8.   TGHNIIHLIHGG	

ACTIVITY TIME
CM CRCT
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•	 Changing the appearance of the text to make it attractive is called formatting of the 
text. 

•	 Font is the characteristic of a specific style and size used for typing the text.
•	 The default font is Calibri and the font size is 11 point.
•	 We can change the font style, size, colour and case.
•	 Highlighting text means placing a coloured rectangle over it.
•	 Alignment refers to how the text is set with respect to the margins in a document. 
•	 We can format a list in a document by using bullets and numbers.

REFRESH

BROWSE

A 	 Choose the correct answer.

	 1. 	� The default font in MS Word 2016 is .

		  a.   Calibri	 	 b.   Arial	 	 c.   Algerian�

	 2. 	� The shortcut key to make the text bold is .

		  a.   Ctrl + I	 	 b.   Ctrl + B	 	 c.   Ctrl + U�

	 3. 	� To outline the text, we have to click on .

		  a.   Text highlight color	 	 b.   Font color	 	 c.   Text effects�

	 4. 	� The shortcut key to align the text left is .

		  a.   Ctrl + E	 	 b.   Ctrl + L	 	 c.   Ctrl + R�

	 5. 	� The shortcut key to Justify text alignment is .

		  a.   Ctrl + J	 	 b.   Ctrl + I	 	 c.   Ctrl + L�
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B 	 Fill in the blanks with the words given below.

	 bullet      11      Ctrl + E      formatting      Ctrl + U

	 1. 	� Changing the appearance of the text to make it more attractive is called 

  of the text.

	 2. 	� The default font size in MS Word 2016 is  point.

	 3. 	� The shortcut key to underline a text in MS Word 2016 is .

	 4. 	� A  is a small symbol such as a dot.

	 5. 	� The shortcut key to align the text in the centre is .

C 	 Write T for true statements and F for false statements.

	 1. 	� We cannot change the font colour in MS Word 2016.�

	 2. 	� MS Word 2016 offers five case options.�

	 3. 	� Colour palette appears by clicking on the drop-down arrow on the  
Text Highlight Color.�

	 4. 	� Pressing Ctrl + B key will italicise the text.�

	 5. 	� You cannot outline the text in MS Word 2016.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	� What does it mean to make the text bold?

		

	 2. 	� What does it mean to italicize the text?
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Match the following buttons with their function.

1. 	�  	 a. 	� to highlight text

2. 	�  	 b. 	� to change font colour

3. 	�  	 c. 	� to centre align the text

4. 	�  	 d. 	� to left align the text

5. 	�  	 e. 	� to format items in a list

ACTIVITY TIME

	 3. 	� What is the default text alignment set in MS Word?

		

	 4. 	� What is the shortcut to align the text towards the right margin?

		

	 5. 	� What does it mean to highlight text?

		

E 	 Answer the following questions.

	 1. 	� Write the steps to change the font size of text?

	 2. 	� List the different case options offered by MS Word.

	 3. 	� What are some of the text effects that can be applied to a text?

	 4. 	� Write the steps to apply border to a document.

	 5. 	� What is a bullet? Write the steps to insert bullets to a document. 

CRCT
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Perform the activity given below in the computer lab.

Open a new MS Word and type the following text.

ALICE was beginning to get very tired of sitting by her sister on the bank, and of having 
nothing to do: once or twice she peeped into the book her sister was reading, but it had 
no pictures or conversations in it, “And what is the use of a book”, thought Alice, “without 
pictures or conversations?”

– Lewis Carroll, Alice’s Adventures in Wonderland

Now, format the text:

•	 Change the font size to 13.
•	 Change the font style to any of your choice. 
•	 Italicise the text.
•	 Bold and underline the author and the book name.
•	 Save and name your document.

LET'S EXPLORE

•	 Elaborate on the formatting features of Word.
•	 Explain the usefulness of the Bullets and Numbering feature.
•	 Show the students the different text effects available in MS Word.
•	 Ask the student to format an unformatted text using all the formatting  

features of Word. 

FOR THE TEACHER

EL TE
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PERIODIC ASSESSMENT 2 

A.	 Identify the following images and write their names.

	 1.	 	 2.  	 3. 

B.	 Fill in the blanks using the words given below.

RED WAVY        SENTENCE CASE        BACKSPACE        REDO        CUTTING

	 1.	  key is used to remove the text.

	 2.	  the text means removing the original text.

	 3.	  is used to reverse the action of the Undo command.

	 4.	  lines represent the spelling mistakes in MS Word.

	 5.	  is used to capitalise the first letter of a sentence.

C.	 Match the following.

	 1.   	 a.  Bold button

	 2.  	 b.  Cut button

	 3.  	 c.  Undo button

	 4.  	 d.  Font Color box

	 5.  	 e.  Text Highlight Color box
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TEST PAPER 1TEST PAPER 1

A.	 Choose the correct option.

	 1.	 1024 Gigabytes makes 1 .

		  a.  Kilobyte	 	 b.  Megabyte	 	 c.  Terabyte	

	 2.	 The Start menu has  panes in Windows 10.

		  a.  three	 	 b.  two	 	 c.  four	

	 3.	 Ctrl + V shortcut key is used for  text.

		  a.  pasting	 	 b.  copying	 	 c.  cutting	

	 4.	 Font group is present in  tab, in MS Word.

		  a.  Insert	 	 b.  Review	 	 c.  Home	

	 5.	 RAM stands for .

		  a.  Random Access Memory	

		  b.  Read Access Memory	

		  c.  Random Adaptable Memory	

B.	 Fill in the blanks.

	 1.	  is a permanent memory.

	 2.	  text is slanted to the right.

	 3.	  the text means duplicating the original text.

	 4.	�   is a flash drive that can be used in mobile 
phones.

	 5.	�   are the shortcuts of applications found in a grid 
on the right pane in Windows 10.

C.	 Write T for true statements and F for false statements.

	 1.	 RAM is also known as non-volatile memory.�

	 2.	 GUI stands for Graphical User Interface.�

	 3.	 Taskbar is an icon on the desktop.�

Computer G4_Ch-4.indd   54Computer G4_Ch-4.indd   54 27-02-2023   11:10:1227-02-2023   11:10:12



55Test Paper 1

	 4.	 Text cannot be inserted in between the existing words in MS Word.�

	 5.	 In MS Word, Font style can be changed by using Font box.�

D.	 Short answer type questions.

	 1.	 Name the types of computer memory.

	 2.	 What is meant by text alignment in MS Word?

	 3.	 Which two keys can you use to delete text in MS Word?

	 4.	 Write the name of any four components of the desktop.

	 5.	 What is the shortcut key to make text bold in MS Word?

E.	 Long answer type questions.

	 1.	 Define secondary memory and its types.

	 2.	 What is meant by resizing a tile? How can you do this?

	 3.	 How can you check spelling in MS Word?

	 4.	 Mention any five ways to select text by using a keyboard.

	 5.	 Write the steps to apply border on the page in MS Word.
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Introduction to  
MS PowerPoint 20165

LEARNING OBJECTIVES

In this chapter, students will learn about:

Starting MS PowerPoint 2016

Parts of PowerPoint window

Creating a new presentation

Entering text in the slide

Adding new slides

Deleting a slide 

Viewing a presentation

Saving a presentation

Existing PowerPoint

SIGN IN

Write one or two sentences for each of the pictures given below. Arrange it in the  
way you want and share it with the class.

1.

2.

3.

4.

Scan QR Code to
watch a video

CMCR

Computer G4_Ch-5.indd   56Computer G4_Ch-5.indd   56 27-02-2023   11:11:3927-02-2023   11:11:39
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PowerPoint was originally called ‘Presenter’ and was created by a software company 
named Forethought, Inc in 1987 and was brought by Microsoft in the same year.

NEWS FEED

When you share what you have written in the above exercise, you are presenting some 
information about the pictures to the class. So, what is a presentation and how do we  
do it? 

A presentation is a systematic display of information using text, pictures, audio and video. 
We create a presentation to share information or express ideas from a speaker to a group 
of people. It is widely used at offices and schools to inform, educate, etc. 

There are many software which help us to make a presentation. Some of them are 
MS PowerPoint, Apple Keynote, OpenOffice, etc. Let’s learn about MS PowerPoint in 
this chapter. 

MS PowerPoint is an application that helps us in creating presentations using text, 
graphics, pictures and other multimedia. It is developed by Microsoft. It is also called PPT. It 
allows us to create professional and attractive presentations. PowerPoint presentations can 
include pictures, charts, audio, video, etc. 

PowerPoint has many versions such as PowerPoint 2003, 2007, 2010, 2013, 2016 and 2019. 
PowerPoint 2019 is the newer version of PowerPoint. 

The default file format in PowerPoint version 2007 and newer versions is .pptx. The file 
format in PowerPoint version 97 to 2003 is .ppt. 

STARTING MS POWERPOINT 2016
Follow these steps to start MS PowerPoint:

1.	 Click on the Start button.
2.	 Scroll through the list of programs to 

PowerPoint and click on it.

1

2

CM

Computer G4_Ch-5.indd   57Computer G4_Ch-5.indd   57 27-02-2023   11:11:3927-02-2023   11:11:39



58 Chapter 5 I Introduction to  MS PowerPoint 2016

The PowerPoint start screen opens. It is also called the Backstage view. 

MS PowerPoint window

PARTS OF POWERPOINT WINDOW
A PowerPoint window has many parts. Let’s learn about these parts.

Quick Access Toolbar

Ribbon

Slide pane

Status Bar View Buttons

File Tab

Placeholder

Slide

Title Bar Control Buttons
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Title Bar
It is located at the top of the MS PowerPoint window. It displays the name of the current 
presentation you are working on. It also shows the name of the program. 

Control Buttons
The three control buttons—Minimize Button, Maximize/Restore Down Button and Close 
button are located on the right side of the Title Bar. 

Quick Access Toolbar
It appears on the top left corner of the MS PowerPoint screen. It consists of icons for 
features that are frequently used such as Save, Undo and Redo. It also has the button 
Start from the Beginning. This button is used to start a slide show. 

Ribbon
It is located below the Title bar. It has tabs such as Home, Insert, etc. These tabs consist of 
groups of related commands. 

File tab
It shows a backstage view that contains commands such as New, Open, Save, Print, etc. 

Slide
It is a single page of a presentation. It contains information about the presentation topic. 

Placeholder
It is a dotted box present on a slide. It may contain text, images, videos, etc. 

Slide pane
It is located on the left side of the window. It shows the thumbnails of all the slides in the 
presentation. 

Status Bar
It is located at the bottom of the window. It gives information about the presentation such 
as the number of the current slide and the total number of slides in the presentation. 

View Buttons
It is located on the right side of the status bar. It gives options for viewing. 

Slide Sorter View

Normal View

This is the 
default view in a 
presentation. Reading View

Slide Show View 
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CREATING A NEW PRESENTATION
A presentation consists of many slides. The default slide that opens when we start a 
presentation is the title slide. This slide has two placeholders. 

Follow these steps to start a new presentation:

1.	 Click on the File tab.
2.	 Click on the Blank Presentation. A new presentation with a blank slide will open.

1

1

A new blank presentation

QUICK BYTE

The shortcut key to open a new blank presentation: Ctrl + N

ENTERING TEXT IN THE SLIDE
Follow these steps to enter text inside the placeholder:

In Title Placeholder
1.	 Click on the title text placeholder (Click to add title) box. 
2.	 Type your text in the text placeholder. For example, in the image given below, the text 

entered is Presentation.

CM
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	 The type text is displayed in the title text placeholder and the Slide pane. 

Text placeholder

Title Slide

In Subtitle Text Placeholder
1.	 Click on the subtitle text placeholder (Click to add subtitle) box. 
2.	 Type your text in the text placeholder. For example, in the image given below, the text 

entered is Microsoft PowerPoint.
	 The typed text is displayed in the title text placeholder and the Slide Pane.

INSERTING A NEW SLIDE
We need to add new slides to create a presentation. We can add any number of slides as 
required. 

Subtitle text placeholder
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Follow these steps to insert a new slide:

Method 1

1.	 Click on the Home tab.
2.	 Click on the New Slide command in the 

Slides group.
3.	 Select the type of style you want and click 

on it. A new slide is added. The new slide can 
also be seen on the Slide Pane.

Method 2

1.	 Right-click on the Slide Pane. A pop-up 
menu will appear.

2.	 Click on the New Slide option. A new slide is 
added. 

A new slide is added

1

2

1 2

3

QUICK BYTE

The shortcut to insert a new slide: Ctrl + M

There is no limit to the number of slides in a PowerPoint presentation.

NEWS FEED

CM

CM
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DELETING TEXT IN A PLACEHOLDER
Follow these steps to delete text in a placeholder:

1.	 Select the placeholder by clicking its border.
2.	 Press the Delete key. This will delete the text in the placeholder. 

We can delete text in multiple placeholders at the same time. To delete text in more than 
one placeholder, hold down the Ctrl key and click on the border of each text box. Then, 
press the Delete key. 

The text is deleted

1

DELETING A SLIDE
Follow these steps to delete a slide:

1.	 On the Slides pane, select and right-click on the slide that you 
want to delete. A pop-up menu will appear.

2.	 Click on Delete Slide on the pop-up menu. The slide will be 
deleted. 

VIEWING A PRESENTATION
We can view each slide of a PowerPoint presentation one after 
the other, in a set pattern. A slide show is a display of slides in a 
prearranged sequence on full screen. 

Follow these steps to view a slide show:

Method 1

1.	 Click on the Slide Show tab on the Ribbon.
2.	 Click From Beginning from the Slide Show group.

1

2

1

2
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Method 2

Click on the Slide Show icon  on the Status bar. The slide show will begin. 

QUICK BYTE

The shortcut key to view the slide show from the beginning: F5

The shortcut key to view the slide show from the current slide: Shift + F5

The shortcut key to exit the slide show: Esc

SAVING A PRESENTATION
To use the presentation or share it with others, we need to save the presentation.

Follow these steps to save a presentation:

1.	 Click on the File tab.
2.	 Click on the Save or Save As button. 
	 Or click on the Save button on the Quick Access Toolbar. The Save As dialog will appear.
3.	 Select the location you want to save the file. Select This PC and click on the Browse option.
4.	 Type a name for the file in the File name text box. 
	 Click on the Save button. The presentation is saved and the file name will appear on 

the title bar. 

1

2

3

4 5

CM
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CLOSING A PRESENTATION
Follow these steps to close a presentation:

1.	 Click on the File tab.
2.	 Click on the Close option. If the presentation is not saved, a message box will appear 

asking ‘Save your changes to this file?’
3.	 Click on the Save button if you want to save the changes.

	 Or Click on Don’t Save button if you do not want to save the changes. 

We can also close the presentation by clicking on the Close button in the Title bar.

QUICK BYTE

The shortcut key to save a presentation: Ctrl + S

Close button

2

1

3

CM
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Find the following words in the word puzzle.

Backstage    Presentation    Slides    Placeholder 
Ribbon    Slideshow    Powerpoint    Slide Pane

G P F L S J Q A R I B B O N S S G B

O T L Z L Z S A X H K L F T L Y P S

S C U A P O W E R P O I N T I J R F

H L Y Q C N J H S L I D E S D W Q K

O M I B R E G P R L M B S S E T H M

H K K D H B H Y L F L L K Z S Q X E

Z N W Y E J U O E H P W G A H E B Y

N W E Z C P U X L W N Z T I O A W H

B A C K S T A G E D E T B L W I C B

A Y Y U C L H N G B E G Y K L F W L

J M D S S Z W I E N U R F J J P F S

V P R E S E N T A T I O N U L U H W

ACTIVITY TIME

•	 MS PowerPoint is an application that helps us in creating presentations using text, 
graphics, pictures and other multimedia.

•	 A PowerPoint window has many parts such as Title Bar, Slide, Placeholder, Status 
Bar, etc.

•	 The title bar displays the name of the current presentation you are working on.
•	 A placeholder is a dotted box present on a slide. 
•	 A presentation consists of many slides.
•	 A slide is a single page of a presentation.
•	 A slide show is a display of slides in a prearranged sequence on full screen.
•	 PowerPoint presentations can include pictures, charts, audio, video, etc.

REFRESH

PL
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BROWSE

A 	 Choose the correct option. 

	 1. 	 It displays the name of the presentation you are working on.

		  a.   Title bar	 	 b.  � Quick Access	 	 c.   Status Bar�  
Toolbar

	 2. 	 It is the default view of a presentation on PowerPoint.

		  a.   Slide sorter view	 	 b.   Normal view	 	 c. 	 Reading view�

	 3. 	 It shows the number of the current slide we are working on.

		  a.   Status bar	 	 b.   Slide pane	 	 c.   View Buttons�

	 4. 	� It is the default slide that appears when we open a new PowerPoint window. 

		  a.   New Slide	 	 b.   Title Slide	 	 c.   Backstage�

	 5. 	 It consists of icons for features that are frequently used.

		  a.   Control buttons	 	 b.   View buttons	 	 c.  � Quick Access�  
Toolbar

B 	 Fill in the blanks using the words given below.

	 Placeholder    Ribbon    four    MS PowerPoint    Slide pane

	 1. 	  is a presentation software.

	 2. 	 A dotted rectangular box on a slide is called .

	 3. 	�   shows the thumbnails of all the slides in the 

presentation.

	 4. 	  has tabs such as Home, Insert, etc. 

	 5. 	� MS PowerPoint has  options to view a presentation.
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C 	 Write T for true statement and F for false statement. 

	 1. 	 A slide is a single page of a presentation.�

	 2. 	 Status bar is located at the top of the PowerPoint window.�

	 3. 	 A Title slide has only one placeholder. �

	 4. 	 We click inside the placeholder to type in it. �

	 5. 	 We can click on  button on the status bar to start a slide show.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	 What is the shortcut to open a new blank presentation?

		

	 2. 	 What is the shortcut to insert a new slide?

		

	 3. 	 What is the shortcut to view a slide show from the beginning?

		

	 4. 	 What is the shortcut to exit a slide show?

		

	 5. 	 What is the shortcut to save a presentation?

		

E 	 Answer the following questions.

	 1. 	 What is MS PowerPoint? Write the steps to create a presentation. 

	 2. 	 Describe any two parts of PowerPoint window.

Computer G4_Ch-5.indd   68Computer G4_Ch-5.indd   68 27-02-2023   11:11:4127-02-2023   11:11:41



69Chapter 5 I Introduction to  MS PowerPoint 2016

	 3. 	� What is a slide show? Write the different ways in which you can view a 
slide show.

	 4. 	 Write the steps to delete a slide.

	 5. 	 Write the steps to save a presentation.

Label the parts of PowerPoint window

ACTIVITY TIME
CT
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•	 Discuss about the importance and effectiveness of presentations.
•	 Show the students a presentation to make their understanding easier.

FOR THE TEACHER

Using PowerPoint 2016, make a presentation on the topic “My Life”.

Instructions:

•	 Open PowerPoint 2016.
•	 Make a title slide entitled “My Life”. Write your name on the subtitle placeholder. 
•	 On the second slide, write the title “Three Interesting Facts About Me” and write 

three facts about yourself.
•	 On the third slide, write the title “Three Things I want to do” and write what you to 

do in future.
•	 Now, view the presentation from the beginning.
•	 Then exit the presentation and save it. Name the file as “All About Me” 

LET'S EXPLORE
EL CMTE
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More on the Internet6

LEARNING OBJECTIVES

In this chapter, students will learn about:

How the Internet started

Terms related to the Internet

Microsoft Edge

Computer Virus

Antivirus software

SIGN IN

Why do people use the Internet? Fill in the missing letters.

E  A  L R  S   R C 

 N    T  I N M  N T H  P   N G

P   M   T

Internet

Scan QR Code to
watch a video

CM
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THE INTERNET
The Internet is a well-connected network of computers all over the world. It is also called 
simply ‘the net’. It enables all the connected computers to share information. Through an 
Internet connection, we can communicate with people from anywhere. 

HOW THE INTERNET STARTED
The Internet is a result of a research experiment by the Defense Department of the United 
States of America. They set up a research agency, Advanced Research Project Agency 
(ARPA), for carrying out research for the military. In 1969, ARPA set up a network of 
computers called ARPANET (Advanced Research Project Agency Network). This network 
enables the computer to share and exchange data. After some time, the United States 
Government opened ARPANET for educational purposes. This leads to many universities 
and government agencies connected through this network. Thus, the network grew bigger 
and gave birth to the Internet.

TERMS RELATED TO THE INTERNET

World Wide Web
World Wide Web (WWW) is commonly known as the Web. It has the largest collection of 
information in the form of websites on the Internet. Through the Web, we can get access 
to various information found over the Internet. This information can be in the form of text, 
images, audio, video, etc. 

Web Page
A web page is a digital page similar to the page of a book that contains information about 
a single topic. It is a part of a website. 

Website
A website is a collection of web pages. These pages have related content. The first page 
of the website is called the home page. Some examples of websites are Google, Wikipedia, 
Facebook, YouTube and Amazon. 

Google.com is the most visited website in the world. 

URL (Uniform Resource Locator)
URL (Uniform Resource Locator) is the unique address of a website or web page. Each 
website and web page has a specific URL. The URL of a website starts with http://. The 
URL for the website for banks and e-commerce starts with https://. The ‘s’ here stands for 
secure which means the website is safe and secure for browsing.
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Web Browser
A web browser is an application software used to access information on the World Wide 
Web. When we enter a keyword related to the information we are looking for, the web 
browser looks for the data from the web. Then the results in the form of links to the web 
pages are displayed on the screen of computer. Some commonly used web browsers are 
Microsoft Edge, Mozilla Firefox, Google Chrome, Opera and Apple Safari.

Google Chrome Mozilla Firefox Opera Apple Safari Microsoft Edge

Hyperlink
Hyperlinks are text or images that when we click give access to another webpage, image, 
document or other content. Hyperlinks are highlighted and underlined in blue. Hyperlinks 
are also called links as they are linked to other locations or files. 

Downloading
It means receiving data or a file from host computer 
(server) through the Internet on our computer. We 
can download varieties of file such as images, videos, 
music, games and software from the Internet. 

Uploading
It means sending data or file from our computer to 
the host computer through the Internet. We can upload 
and share different files such as pictures, videos, 
documents, etc.

Internet Service Provider (ISP)
An ISP is a company that provides us access to the Internet for specific fees. BSNL, MTNL, 
Reliance Communication, Airtel and Vi are some popular service providers in India.
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Search Engine
A search engine is software that is used to search or look for information on the Internet. 
Some popular search engines are www.google.com, www.yahoo.com, www.bing.com, etc. 

Follow these steps to access a website using a search engine:

1.	 Click on the web browser icon to open a web browser.
2.	 Enter the URL (or web address) of the website in the Address bar of the browser.
3.	 Press the Enter key. The web server locates the file and the web browser displays the 

page on the screen. 

Microsoft Edge
The default web browser in the Windows 10 operating system is Microsoft Edge.

Follow these steps to open Microsoft Edge:

1.	 Step on the Start button.
2.	 Search Microsoft Edge. 
3.	 Click on Microsoft Edge.
	 Or 
	 Click on the icon of Microsoft Edge on the Taskbar. 

	 The web browser will open. 
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Parts of Microsoft Edge Window
Microsoft Edge Window has many parts.

Current Tab

Back

Refresh

Address Bar

Search Bar

Favourites MoreNew Tab

Current tab: Microsoft Edge uses tabs for each opened web page.

Backward: Click on this button to go back to the previous web page. 

New Tab: Click this button to open a new tab.

Refresh: Click on this button to refresh the page.

Address Bar: Type the web address or the URL of the web page you want to open.

Search Bar: Microsoft Bing is the default web engine for Edge. Type the keywords or 
phrases for the information you are looking for. 

Favourites: This star icon helps us to set a web page as a favourite. This helps us to easily 
open the page when we want to read it again. 

More: Click on this button to see the extra features such as zoom, print, share, etc.

COMPUTER VIRUS
How do you feel when you are not well? How do you know you are not well?

When we are not well, our body is not able to function normally as it used to.

One of the most common diseases that make us sick is viral fever. It is caused by a virus. 
The virus infects and attacks our bodies making us weak and unfit to do most activities. 

A computer system can also get infected by a virus. It will not able to work properly when 
it gets infected with a virus. The virus that attacks a computer is a program. 
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A computer virus is a program or application that duplicates itself and causes harm to 
the computer. It is installed without the user’s knowledge. It infects the programs and files 
that keep the computer from working normally or makes the computer stops working 
altogether. It gets transferred from one system to another like a human virus that is 
spread from one person to another. It is spread from one system to another by hiding 
through a document or an application. Some examples of computer viruses are Worms, 
Trojans and Ransomware.

How a virus harms a computer
Computer viruses are of different types and can infect a 
device in different ways. Some of the harms caused by the 
virus are:

•	 It can damage programs.
•	 It can delete files.
•	 It can keep on restarting the computer on its own.
•	 It can stop the computer from starting. 
•	 It can crash your hard disk.
•	 It can decrease the processing speed of the computer.
•	 It can send harmful emails from your account. 

How a virus-infected computer performs
A computer may be infected if:

•	 The computer takes more time in opening and closing a program.
•	 The computer keeps shutting down by itself.
•	 Some unusual messages or a different window opens up when you try to open a 

window.
•	 Some of the files or programs go missing without any reason.

How a computer gets a virus
There are many ways through which computer viruses are transferred from one system to 
another. These are some of the ways:

•	 Sharing files such as music, images, and documents from an infected system to another 
system.

•	 Using pen drives that are infected with a virus. 

A man with a laptop 
infected with virus

The first computer virus is known as ‘Brain’ and was released in 1986. 

NEWS FEED
CM

Computer G4_Ch-6.indd   76Computer G4_Ch-6.indd   76 21-02-2023   10:21:3721-02-2023   10:21:37



77Chapter 6 I More on the Internet

•	 Downloading files from the Internet such as free games, movies and songs.
•	 Downloading programs or software from the Internet. 
•	 Visiting websites that are infected with viruses.
•	 Opening or downloading an infected email attachment 

How to protect a computer from a virus
A computer virus can cause harm to our computer, so we should be 
careful that viruses do not infect the computer. These are some of the 
practices that will help to avoid a computer infecting with a virus:

•	 Do not open any email attachments from unknown senders.
•	 Do not visit unsafe or suspicious websites.
•	 Avoid downloading programs, games or music from a source that is 

not official. 
•	 Install antivirus software that will protect the computer from viruses.

ANTIVIRUS SOFTWARE
An antivirus is software that can detect 
viruses in a computer. It is installed on 
the computer. When a system has an 
antivirus, it does not allow the virus to 
copy itself onto the computer. Antivirus 
software can also search through the files 
in a computer and determine those files 
that are infected with viruses. Some of the 
antivirus software are McAfee Antivirus, 
AVAST Antivirus, Norton Antivirus, 
Kaspersky Antivirus, AVG Antivirus etc.

Logos of some of the common antivirus software are given below.

Norton Kaspersky AVGAVASTMcAfe

An antivirus software scanning for virus

The first antivirus software was developed in 1987 by two German inventors Andreas 
Lüning and Kai Figge

NEWS FEED
CM
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Identify the software that will be used to scan virus. Circle them.

1. 							       2. 	

3. 						 	        4.  

5.  							       6.  

7.  							       8.  

ACTIVITY TIME

•	 The Internet is a well-connected network of computers all over the world.
•	 World Wide Web (WWW) is the largest collection of information in the form of 

websites on the Internet.
•	 A website is a collection of web pages.
•	 URL (Uniform Resource Locator) is the unique address of a website or web page.
•	 An ISP is a company that provides us access to the Internet for specific fees.
•	 A search engine is software that is used to search or look for information on the 

Internet.
•	 The default web browser in the Windows 10 operating system is Microsoft Edge.
•	 A computer virus is a program or application that duplicates itself and causes harm 

to the computer.
•	 An antivirus is software that can detect viruses in a computer.

REFRESH

CT
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A 	 Choose the correct option.

	 1. 	 ARPANET stands for .

		  a.   Advanced Research Project Agency Networking	

		  b.   Advanced Researching Project Agency Network	

		  c.   Advanced Research Project Agency Network		

	 2. 	 WWW stands for .

		  a.   World Wide	 	 b.   World Whole	 	 c.   World With	
		  Web		  Web		  Web

	 3. 	 URL stands for .

		  a.   Uniform Resource Location	 	 b.   Uniform Resource Locator	

		  c.   Uniform Resource Locating	

	 4. 	 Which of the following is not a search engine?

		  a.   www.google.com	 	 b.   www.India.com	

		  c.   www.yahoo.com	

	 5. 	 Which of the following is not a web browser?

		  a.   	 	 b.   	 	 c.   	

B 	 Fill in the blanks with the words given below.

	 web page    Downloading    Web    Hyperlinks    Internet

	 1. 	� The  is a well-connected network of computers  

all over the world.

	 2. 	�   has the largest collection of information in the 

form of websites on the Internet.

BROWSE
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	 3. 	� A  is a digital page similar to the page of a book.

	 4. 	�   are text or images that when we click give 

access to another webpage.

	 5. 	�   means receiving data or a file from the host 

computer through the Internet.

C 	 Write T for true statements and F for false statements.

	 1. 	 Clicking on the refresh button opens a new tab.�

	 2. 	 Chrome is the default search engine for Edge.�

	 3. 	� A computer gets a virus visiting websites that are infected with viruses.�

	 4. 	 A computer virus can cause harm to computers.�

	 5. 	 The URL of a website starts with http://.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	 What is commonly known as the web?

		

	 2. 	 What do you call the collection of web pages?

		

	 3. 	 Give two examples of web browsers.

		

	 4. 	 Give two examples of ISP.

		

	 5. 	 Give two examples of antivirus software.
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E 	 Answer the following questions.

	 1. 	 What is a computer virus?

	 2. 	 How does a virus harm a computer?

	 3. 	 How does a computer get infected by a virus?

	 4. 	 How can you protect a computer from a virus? 

	 5. 	 What is antivirus software?

Identify the following pictures and write the correct term from the box.

IPS    Anti-virus    URL    web browser    Search engine    Email

ACTIVITY TIME

https://www.google.com

1.  	  2.  

3.  	  4.  

5.  	  6.  

CM
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In the computer lab, do these activities:

Activity 1: Using the Internet search for information on any topic that you want to know 
about. Start the web browser. Then, open the search engine and type the topic.

Activity 2:  Scan the computer for virus using an antivirus software. Learn which 
software is used.

LET'S EXPLORE

•	 Elaborate on the importance of the Internet in our life.
•	 Show them how to search for information using search engines.
•	 Explain that there are many Internet service providers. 
•	 Explain the importance of scanning a file for virus and show how to do it using an 

antivirus software.  

FOR THE TEACHER

EL TE
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PERIODIC ASSESSMENT 3 

A.	 Identify the following images and write their names.

	   

	 1.	 	 2.  	 3. 

B.	 Fill in the blanks using the words given below.

SLIDE      ANTIVIRUS      SLIDE PANE      NET      WEB PAGES

	 1.	  is the software that detects viruses in the computer.

	 2.	 The Internet is also known as the .

	 3.	  is the single page of the presentation.

	 4.	 Website is the collection of .

	 5.	  shows the thumbnail of all the slides in the presentation.

C.	 Match the following.

	 1.	 Ctrl+M	 a.  McAfee

	 2.	 Ctrl+S	 b.  To open new blank presentation

	 3.	 Ctrl+N	 c.  Airtel

	 4.	 Antivirus	 d.  To insert new slide a presentation

	 5.	 Internet Service Provider	 e.  To save a presentation
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Introduction to Scratch7

LEARNING OBJECTIVES

In this chapter, students will learn about:

Starting Scratch

Parts of Scratch window 

Scratch Blocks

Choosing a sprite

Deleting a sprite

Choosing a Backdrop

Saving the project

SIGN IN

Look at the map chart and answer the questions.

START

Forward

Backward

Left

Right

Scan QR Code to
watch a video

CRCT
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1.	 From Start, take 3 steps forward and 1 step right. Where are you?
2.	 From Start, take 1 step forward, 2 steps right and 1 step forward. 
	 Where are you?
3.	 From Start, take 3 steps right, 4 steps forward and 3 steps backward. 
	 Where are you?
4.	 From Start, take 1 step right, 4 steps forward and 1 step left. 
	 Where are you? 
5.	 From Start, take 1 step right, 4 steps forward, 3 steps right and 4 steps backward.

Understanding instructions and following them step-by-step is important to solve a 
problem. A computer works in the same way. It follows step-by-step instructions from 
us. These instructions that we give to the computer are called programming. In the 
previous class, we have learnt about a programming language that is used to draw and 
do mathematical calculations. In this chapter, we will learn about another programming 
language, Scratch.

SCRATCH
Scratch is a programming language that helps young children to learn computer 
programming in an exciting way. It can be used to create games, interactive stories and 
animations. It has many fun tools that can help you to create your project. It has a big 
collection of sounds, music, graphics and animations that can be used to create interesting 
projects. 

STARTING SCRATCH 
Scratch window can be opened in two ways.

Method 1

1.	 If this icon  (Scratch shortcut icon) is there on the 
desktop, double-click on it. It will open the Scratch 
window. 

Method 2

1.	 Click on the Start button. Scroll through the list 
	 of programs and search for Scratch 3.
2.	 Click on Scratch 3. The Scratch Window  

appears.

1

2
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Parts of Scratch Window
A Scratch window has many parts. Let us learn about these parts in detail.

Sprite Info Pane

Scripts Area/ 
Code Area

Menu Bar Project Name Go Button
Stop Button

Title Bar

Tabs

Sprite
Block Menu

Stage

Block Palette

Title Bar
It is located at the top of the Scratch window. The name of the program is shown on the left 
side. On the right side of the title bar, there are three control buttons—Minimise, Maximise 
and Close.

Menu Bar
It is used to provide a drop-down that provides commands such as create a new, open an 
existing file or save the new file.

Project name
It shows the name of the project you are creating.

Go Button
Itis the green flag  present on the Screen window. We click on this button to run a Scratch 
program.

Scratch was created by Scratcher Jocelyn and Mitchel Resnick, of the Lifelong 
Kindergarten group at MIT Media lab in 2007.

NEWS FEED
CM
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Stop Button
It is the red button  present on the Screen window. We click on this button to stop a 
program. 

Sprite
It is the object or the main character that follows the instructions given by you. It performs 
the function on the Stage. The orange cat that is displayed on the Stage is the default 
Sprite.

Scripts Area/Code Area
It is the area where the instruction or the scripts is created. The script is created by 
dragging the blocks from the block palette and the Script area. These blocks are placed 
stepwise on top of each other. A script is the stepwise instructions to a sprite, given in the 
form of blocks. A script must have at least two blocks. The script is also called a project. 

Stage
It is the main working area where the sprite performs actions. It shows the work that you 
have done. You can also play games and watch stories on the stage. The background of 
the stage is called the backdrop.

Sprite Info Pane
It is located directly below the Stage area. It displays small thumbnail versions of all the 
sprites and backdrops used in the project. In this area, we can add, delete, and change the 
size of the Sprite.

Tabs
Scratch has three main tabs.

•	 Code tab: It contains different block categories. It also contains 
the list of several script blocks of each category. The different 
types of block categories are—Motion, Looks, Sound, Events, 
Control, Sensing, Operators, Variables and My Blocks. These 
blocks are of different colours. Each block performs a different 
task. The script blocks connect like a jigsaw and create scripts. 

•	 Costumes Tab: This tab contains the options to add or make 
changes in the appearance of the sprites and the backdrops. 

•	 Sounds Tab: This tab contains the options to add and make 
changes in the sounds of the sprite and backdrop.

Block Menu
It shows the categories of blocks based on their functions and uses. The blocks 
that share similar function are group into one category and share the some colour. There 
are mainly nine categories of blocks available in Scratch 3.0.
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Block Palette
It contains various blocks that are used to perform specific tasks. Blocks are puzzle-piece 
shapes that are used to create scripts in Scratch. The blocks connect to each other vertically 
like a jigsaw puzzle. When we click on the Code tab, the block palette will open. 

SCRATCH BLOCKS 
Scratch blocks are divided into different categories. Each block performs a different 
function. To create a script, the blocks are dragged onto the script area. To add blocks to 
a script, drag them to the part of the script where you want them to appear. We can add 
blocks above or below the existing blocks. We can see these categories under the Code 
tab. Let us learn about the functions of some blocks. 

Motion Block
The blocks in the blue colour are Motion Blocks. They are used to control the motion of a 
Sprite. These are the uses of some motion blocks: 

•	 Use  block to move the Sprite forward i.e. in the direction it is facing.  
The number inside the textbox is the number of steps the sprite will take.  
We write the number with a minus (-) sign to move the Sprite backwards.  
For example, .

•	 Use  block to turn the Sprite in a clockwise direction. The number given in the 
textbox will be the degree of turn.

•	 Use  block to turn the Sprite in the anti-clockwise direction. The number 

given in the textbox will be the degree of turn.

•	 Use  block to make a Sprite jump to a new position on the stage. 

Looks Block
The blocks in the purple colour are Looks Blocks. They are used to control how a Sprite 
appears onstage. These are the uses of some looks blocks:

•	 Use  block to add a speech bubble to the Sprite. The number given in the 

textbox is the duration of the speech in seconds.

•	 Use  block to add a speech bubble to the Sprite with the given text. The speech 

will appear till the stop button is clicked.

•	 Use  block to add a thought bubble with the given text. The number 

given in the textbox is the duration that the bubble will appear in seconds.

•	 Use  block to add a thought bubble with the given text. The bubble will appear 

till the stop button is clicked.
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•	 Use  to make changes to the Sprite according to the effect selected. For 

example the colour. 

•	 Use  and  blocks to show or hide the Sprite on the stage.

Sound Block
The blocks in the pink colour are Sound Blocks. They are used to control sound functions. 
Using sound blocks we can add music or sound to our Scratch project. We can record a 
sound or our voice and use it in the Sounds block. These are the uses of some sound blocks:

•	 Use  block to play a sound while pausing the Script.

•	 Use  block to play a sound without pausing the Script.

•	 Use  block to stop all sound being played.

•	 Use  block to clear all the existing sound effects.

Events Block
The blocks in the yellow colour are Events Blocks. An event block triggers scripts to run. 
It controls how a particular action is done in a script. Events blocks control the events of 
scripts. These are the uses of some events blocks:

•	 The block  activates the script when the green flag is clicked.

•	 The block  activates the script when the chosen key is pressed. 

•	 The block  activates the script when you click the sprite.

Control Block
The blocks in orange colour are the Control Blocks. It controls how many times an event is 
repeated, how long an event happens or how long an event happens. These are the uses of 
some events blocks:

•	 Use  block to pause the running of the script. The number given in the textbox 
is how long the Sprite will pause in seconds.

•	 Use  block to repeat a set of blocks for the given number of times given in the 

text below.

•	 Use  block to repeat a set of blocks till the stop button is clicked. 

CHOOSING A SPRITE
Scratch has a default sprite, the cat. The cat is located at the center of the stage. We can 
add more sprites to the stage.
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90 Chapter 7 I Introduction to Scratch

Follow these steps to add another sprite to the stage: 

1.	 Click on the Choose a Sprite tool in the Sprite Info Pane.
	 A Choose a Sprite window will open. It shows the available sprites you can choose from.
2.	 Click on the Sprite you want to add to your project. Here we have added a bear. Now, 

there are 2 sprite thumbnails in the Sprite Info Pane.

1

2 Thumbnail of two sprites

DELETING A SPRITE
A Sprite that we add on the stage can be removed or deleted.

Follow these steps to delete a Sprite:

1.	 Click on the thumbnail of the Sprite you want to delete in the Sprite Info Pane.
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2.	 Click on the cross symbol  that appears on the thumbnail of the Sprite.
	 The Sprite will be deleted from the stage.

2

1

CHOOSING A BACKDROP
A backdrop is the background of the stage. We can choose a backdrop from the available 
backdrop in Scratch. 

Follow these steps to choose a backdrop:

1.	 Click on the Choose a Backdrop tool in the Sprite Info Pane.
	 A Choose a Backdrop window will open. It shows the available backdrops that you can 

choose. 
2.	 Click on a backdrop you want to add to your project. Here, the castle 2 backdrop is 

added. The thumbnail of the backdrop will appear in the Sprite Info Pane.

1

2
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SAVING THE PROJECT
After a project is created, we need to save it.

Follow these steps to save a project:

1.	 Click on the File tab.
2.	 Click on Save to your computer. The Save as dialog box appears. 
3.	 Choose the location where you want to save the project. Type the name in the File 

name box and click on the Save button.

2 3

1

Scratch is available for free download at http://scratch.mit.edu. 

NEWS FEED

Match the following.

1.   	 a.   Looks Block

2.   	 b.   Motion Block

3.   	 c.   Control Block

4.   	 d.   Events Block

5.   	 e.   Sound Block

ACTIVITY TIME

CM

CRCT
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93Chapter 7 I Introduction to Scratch

•	 Scratch is a programming language for young children.
•	 Scratch is used to create games, interactive stories and animations.
•	 Sprite is the object or the main character that follows the instructions  

given by you.
•	 Scripts area is the area where the instruction or the script is created.
•	 Stage is the main working area where the sprite performs actions.
•	 A script is the stepwise instructions to a sprite, given in the form of blocks.
•	 Sprite Info Pane displays the detail of all the sprites and backdrops used. 
•	 Scratch has three main tabs—Code tab, Costumes tab and Sounds tab.
•	 Blocks are puzzle-piece shapes that are used to create a script in Scratch.
•	 Block palette contains various blocks that are used to perform specific tasks.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	� It is the green flag present on the window.

		  a.   Stop Button	 	 b.   Go Button	 	 c.   Sprite	

	 2. 	� The background of stage is called .

		  a.   Background	 	 b.   Project	 	 c.   Backdrop	

	 3. 	� These blocks are used to control how a sprite appears on stage. 

		  a.   Motion Blocks	 	 b.   Looks Blocks	 	 c.   Sound Blocks	

	 4. 	� These blocks are yellow in colour.

		  a.   Events Blocks	 	 b.   Sound Blocks	 	 c.   Looks Blocks	

	 5. 	� The cat is located at the .

		  a.   Centre of the stage	 	 b.   Right end of the stage	

		  c.   left end of the stage	
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94 Chapter 7 I Introduction to Scratch

B 	 Fill in the blanks with the words given below.

	 script    Code    motion    programming    red

	 1. 	� Scratch is a �  language. 

	 2. 	� We click on the  button to stop a program.

	 3. 	� A  is the stepwise instruction to a sprite, given 

in the form of blocks. 

	 4. 	�   tab contains different block categories. 

	 5. 	� The blocks in the blue colour are �  blocks.

C 	 Write T for true statements and F for false statements. 

	 1. 	� The Looks block is pink in colour.�

	 2. 	� The orange cat is the default sprite in scratch.�

	 3. 	� The script is also called a project.�

	 4. 	� Costumes tab contains the options to add and make changes in the  
sound of sprite and backdrop.�

	 5. 	� Blocks are puzzle-piece shapes that are used to create scripts in scratch.�

D 	 Answer the following questions in one word or two words.

	 1. 	� Which tab contains the options to add or make changes in the appearance 
of the sprites?

		

	 2. 	� Which blocks are used to control sound functions?
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95Chapter 7 I Introduction to Scratch

	 3. 	� Which blocks are used to control the motion of a sprite?

		

	 4. 	� Which blocks control how a particular action is done in a script? 

		

	 5. 	� Where are the small thumbnail versions of all the sprites used in the project 
displayed?

		

E 	 Answer the following questions.

	 1. 	� What is Scratch? 

	 2. 	� What is a sprite? 

	 3. 	� What is a stage?

	 4. 	� What is the function of the Looks block? 

	 5. 	� What is the function of the Control blocks? 

Label the different parts of Scratch window.

ACTIVITY TIME
CMCT
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96 Chapter 7 I Introduction to Scratch

Create a program in Scratch. Do this activity in the computer lab. 

Follow these steps to create the program:

1.	 Choose an animal					   

2.	 Add a sound						    

3.	 Make it change colour				  

4.	 Add a background					   

5.	 Make the animal move forward			 

LET'S EXPLORE

•	 Explain that Scratch has different blocks that are used to create programs.
•	 Elaborate on the different functions of the blocks.
•	 Demonstrate how to create a program in Scratch. 

FOR THE TEACHER

EL TE
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Drawing in Scratch8

LEARNING OBJECTIVES

In this chapter, students will learn about:

Pen Block

Drawing a Line

Drawing a Polygon 

Drawing a Square 

Drawing a Circle

SIGN IN

Identify the words related to Scratch. Put a tick on them.

Sound Block
LOGO

Events Block Sprite

Stage
Backdrop

Commander window

Control Block

Drawing Area

Stamp

Graphic Screen

Left Turn

Right Turn Backward

Forward

Repeat 4

Move 10 Steps

Scan QR Code to
watch a video

CT
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98 Chapter 8 I Drawing in Scratch

We have learnt that Scratch can be used to create games and animations. Scratch can 
also be used to create various shapes. To create shapes in Scratch, we use Pen blocks. Let 
us learn how to create shapes using the Pen block.

Pen Block
The Pen blocks allow a Sprite to draw shapes in Scratch. These blocks are green in colour. 
In Search 3.0, we have to add Pen blocks to the block category. 

Follow these steps to add Pen blocks:

1.	 Click on the Add Extension button  at the bottom left corner of the Code tab. A 
Choose an Extension window will open.

2.	 Click on the Pen option. The Pen blocks will be added to the Code tab.

Pen blocks under 
Code tab

Uses of Pen blocks
These are the uses of Pen block:

		  This block is used to erase all the pen marks on the screen.

		�  This block is used to create a copy of the Sprite. The image is stamped 
on the stage. The copied image will appear behind the Sprite. To see the 
image, click on the Sprite and drag.

1

2
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99Chapter 8 I Drawing in Scratch

		�  This block is used to put Sprite’s pen up and does not draw anything 
when it moves.

		�  This block is used to put Sprite’s pen down 
and draws as it moves.

	� This block is used to change the colour of 
the pen. We can choose the colour from the  
drop-down menu. 

	�This block is used to change the properties 
of the pen such as colour, saturation, 
brightness and transparency. 

1.	 Click on the first textbox to select the changes and change 
the pen properties.

2.	 Click on the second textbox to set the value 
by which the properties will change.

	�This block is used to set the 
properties of the pen that is 

colour, saturation, brightness and 

transparency to the given value. 

	� This block is used to change the 

size of the pen by the chosen 

number.

	� This block is used to set the size 

of the pen to a chosen number. 

DRAWING A LINE
Follow these steps to draw a line:

1.	 Drag the  block from the Events block menu.

2.	 Drag the  and  blocks from the Pen block menu.

3.	 From the Motion block menu, drag the  block. Change the value to 100 so 
that it becomes Move 100 steps. The line appears on the stage. 

21
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We can hide the Sprite to display only the line on the stage. 

To hide the Sprite, drag the block from the Looks block menu. 

DRAWING A POLYGON
A polygon is a 2D closed figure made of connected lines. In a regular polygon—

•	 all angles are equal and all sides are the same length.
•	 the number of sides is equal to the number of angles.

Some examples of polygons are:

Equilateral Triangle

(3 sides)

Square

(4 sides)

Pentagon

(5 sides)

Hexagon

(6 sides)

Scratch is used in more than 150 countries and has been translated into more than 60 
languages. 

NEWS FEED
CM
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Using Repeat Command to draw regular polygons
A Sprite walks along the side of the polygon when it draws the polygon. It turns at a specific 
angle at each turn and turns 360 degrees before coming back. The degree of each turn is 
equal to 360 degrees divided by the number of sides. For example, to draw a triangle the 
Sprite has to turn three times and the degree is equal to 360 degrees divided by 4, that is 
120 degrees.

It is easy to draw regular polygons using the Repeat block as the degree of turn for each 
turn is equal.

Follow these steps to draw a regular polygon using Repeat block:

1.	 Drag the  block from the Events block menu.

2.	 Drag the  and  blocks from the Pen block menu.

3.	 Drag the  block from the Control block menu.

4.	 Drag the  block,  block and  block one by one and attach 
them inside the Repeat block. 

5.	 Change the repeat value, move value and turn value according to 
the polygon you are drawing. 

	 Here, the repeat value is the number of sides, the move value is 
the length of the sides and the turn value is the degree of angle.

	 The script will look like this:

Remember these points to draw a polygon in Scratch:

•	 Must know the number of sides of the figure to be drawn.
•	 Must know the degree of the angle for the turns. To get the degree 

divide 360 by the number of sides in the shape.
•	 Each time a repeat command is used, a line is drawn and turned at a corner.

Heptagon

(7 sides)

Octagon

(8 sides)

Nonagon

(9 sides)

Decagon

(10 sides)
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These are the commands to draw some of the polygons using Repeat block.

Triangle	 	 :  Repeat 3 Move 120 Steps Turn 120 degrees

Square	 	 :  Repeat 4 Move 120 Steps Turn 90 degrees

Pentagon	 	 :  Repeat 5 Move 120 Steps Turn 72 degrees

Hexagon	 	 :  Repeat 6 Move 120 Steps Turn 60 degrees

Heptagon	 	 :  Repeat 7 Move 120 Steps Turn 51 degrees

Octagon	 	 :  Repeat 8 Move 120 Steps Turn 45 degrees

Nonagon	 	 :  Repeat 9 Move 120 Steps Turn 40 degrees

Decagon	 	 :  Repeat 10 Move 120 Steps Turn 36 degrees

DRAWING A SQUARE USING REPEAT BLOCK
Follow these steps to draw a square:

1.	 Drag the  block from the Events block menu.

2.	 Drag the  and  blocks from the Pen block menu.

3.	 Drag the  block from the Control block menu. Change the value to 4 as the 

number of sides of a square is 4.

4.	 Drag the  block,  block and  block one by one and 

attach them inside the Repeat block. Change the values as move 120 steps and turn 
90 degrees.
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DRAWING A CIRCLE USING REPEAT BLOCK
We can also draw a circle or a semicircle using the Repeat block. A full circle is 360 degrees 
and a semicircle is 180 degrees.

Command to draw a circle is:

Repeat 360, Move 1 Step, Turn 1 degree 

Command to draw a semicircle is:

Repeat 180, Move 1 Step, Turn 1 degree 

More than 22 million projects have been created in Scratch with almost 30,000 new ones 
being added every day.

NEWS FEED
CM
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•	 Scratch can be used to create various shapes.
•	 The Pen blocks allow a Sprite to draw shapes in Scratch.
•	 Pen blocks are green in colour.
•	 Stamp Block is used to create a copy of the sprite.
•	 A polygon is a 2D closed figure made of lines connected.
•	 We need to know the number of sides and the degree of the angle for the turns to 

draw a polygon.

REFRESH

BROWSE

ACTIVITY TIME

Identify the shapes.

 		   		    

1. 	 	 2. 	

		  		      

3. 	 	 4. 	

A 	 Choose the correct option.

	 1. 	� The colour of the Pen Blocks is .

		  a.   pink	 	 b.   green	 	 c.   orange	

CM
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	 2. 	� To add a Pen Block, we have to click on  .

		  a.   	 	 b.   	 	 c.   	

	 3. 	� This block is used to create a copy of the sprite. 

		  a.   	 	 b.   	 	 c.   	

	 4. 	� To hide the sprite, we have to drag  from .

		  a.   Looks block	 	 b.   Motions block	 	 c.   Events block	

	 5. 	� The value of a repeat block to draw a full circle.

		  a.   180	 	 b.   360	 	 c.   90	

B 	 Fill in the blanks with the words given below.

	 Extension      3      2D      equal      Pen

	 1. 	� The  blocks allow a sprite to draw shapes in Scratch.

	 2. 	� To draw a triangle, the repeat value should be .

	 3. 	� To use the Pen block, we have to click on ‘Add ’ 
button.

	 4. 	� A polygon is a  closed figure.

	 5. 	� In a regular polygon, all angles are .

C 	 Write T for True Statements and F for False Statements. 

	 1. 	� The Pen up block is used to create a copy of the Sprite.�

	 2. 	� We cannot hide the Sprite from the stage.�

	 3. 	� To draw a triangle, we have to change the repeat value to three.�

	 4. 	� The commands to draw different kinds of polygons are the same.�

	 5. 	� We have to change the repeat value to four to make a square.�  
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D 	 Answer the following questions in one word or one sentence.

	 1. 	� Which block is used to erase the pen marks on the screen?

		

	 2. 	� Which block is used to stop the sprite from drawing anything when it moves?

		

	 3. 	� What would be the repeat value to draw a pentagon?

		

	 4. 	� What would be the turn value to draw a square?

		

	 5. 	� What would be the turn value to draw a heptagon?

		

E 	 Answer the following questions.

	 1. 	� Write the functions of any three Pen blocks.

	 2. 	� What is the command to draw an Octagon?

	 3. 	� Write the steps to draw a line in Scratch?

	 4. 	� What are the points that we should remember to draw a polygon in Scratch?

	 5. 	� Write the commands to draw a circle and a semicircle.

LET'S EXPLORE

Group these blocks in the correct categories. Write the number in the table.

1.   	 2.   	 3.  

4.   	 5.   	 6.  

ACTIVITY TIME
CRCT
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7.   	 8.   	 9.  

10.   	 11.   	 12.  

EVENTS LOOKS MOTION CONTROL PEN 

Using these commands, draw the shapes in Scratch. Identify them. 

•	 Repeat 5, Move 120 Steps, Turn 72 degrees

•	 Repeat 4, Move 120 Steps, Turn 90 degrees

•	 Repeat 6, Move 120 Steps, Turn 60 degrees

•	 Repeat 9, Move 120 Steps, Turn 40 degrees

•	 Repeat 10, Move 120 Steps, Turn 36 degrees

LET'S EXPLORE

•	 Discuss different shapes in the class.
•	 Explain how these different shapes are drawn in Scratch. 
•	 Ask the students to draw them in Scratch. 
•	 Show them how to create program using these shapes. 

FOR THE TEACHER

EL TE
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Evolution of AI9

LEARNING OBJECTIVES

In this chapter, students will learn about:

Evolution of artificial intelligence 

Artificial Intelligence (AI) devices are capable of performing tasks that require intelligence. 
AI makes these devices capable of learning and thinking. Over the years, scientists have 
been working to develop machines that are able to work and behave in the same way as 
humans. There have been many evolutions in the field of artificial intelligence. Let us look 
at the inventions of some of the programs and AI devices. 

SIGN IN

Read the clues and complete the crossword puzzle below.

1

2 3

4

Across

1.	 It is the virtual assistant for 
Apple devices. 

2.	 It is a program that chats with 
humans like a real person. 

4.	 It is the first smart speaker.

Down

1.	 It is like a smart phone that you 
wear on your wrist. 

3.	 It is the virtual assistant for 
Amazon.

Scan QR Code to
watch a video

PL
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1950: THE TURING TEST
In 1950, Alan Turing wrote a paper in which he proposed the idea of 
a test to check whether a machine can think or not. The name of 
the test was the Imitation Game and it was later recognised as the 
Turing Test.

He created Bombe, a machine that could decode the encoded 
messages. This is one of his greatest achievements. 

Bombe

1952: COMPUTER CHECKERS-PLAYING PROGRAM
In 1952, Arthur Samuels developed a checkers playing program. It was the first program 
that could play and compete against human players in the game.

Arthur Samuels playing checkers with his checkers-playing program

Alan Turing
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1966: ELIZA
In 1966, Joseph Weizenbaum developed Eliza, a computer program that can have 
interactions in the English language on almost any topic. 

Joseph Weizenbaum ELIZA

1973: WABOT-1 
In 1973, Ichiro Kato created WABOT-1, a robot that has 
human characteristics. It can walk and grasp objects. 
It can also communicate but initially, it could only 
communicate in Japanese. 

1980: WABOT-2
In 1980, Waseda University’s science and engineering department, 
Japan created the successor of WABOT-1. WABOT-2 was able to 
communicate with a person and could play piano as well.

Wabot-1 Ichiro Kato

1956: LISP PROGRAM 
In 1956, John McCarthy who is known as the father of AI developed 
the Lisp Program. It is a computer programming language. 

Research in AI in India started in 1986 with the launch of the 
Knowledge-Based Computing Systems (KBCS) program in 
conjunction with the United Nations Development by the 
Government of India Program.

NEWS FEED

John McCarthy

Wabot-2

CM

Computer G4_Ch-9.indd   110Computer G4_Ch-9.indd   110 25-02-2023   17:52:4725-02-2023   17:52:47



111Chapter 9 I Evolution of AI

1998: FURBY
In 1988, Dave Hampton and Caleb Chung created Furby, the first pet robot. It can 
communicate with humans. Initially, the words were gibberish but later, it could form clear 
English words. 

Dave Hampton Caleb Chung Furby

1999: AIBO
In 1999, Sony designed and manufactured a robot dog, Aibo. It 
is like an actual dog. It can interact with humans and respond 
on its own. 

2000: ASIMO 
In 2000, Honda released Asimo, a robot 
that had human characteristics. It can walk, 
recognise faces, and use its arms like human beings. 

2002: ROOMBA 
In 2002, iRobot released Roomba, a robot 
vacuum cleaner that cleans on its own 
without crashing into obstacles 

2011: SIRI
In 2011, Apple released a voice-controlled personal assistant 
program for apple devices, Siri. It recognises human language and responds to almost any 
questions asked by the user. 

Like Siri, other companies also developed various virtual assistants. For Example:

•	 Alexa was developed by Amazon in 2014. 
•	 Cortana was developed by Microsoft in 2014. 

Aibo

Asimo

Roomba
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•	 Google Assistant was developed by Google in 2016.

CortanaAlexaSiri Google Assistant

2014: GOOGLE’S DRIVERLESS CAR
In 2009, Google started developing a Self-Driving or 
Driverless car and launched it in 2014. These cars do not 
require a person to operate them. Google’s driverless cars 
use cameras, sensors and artificial intelligence to go from 
one place to another. 

2016: SOPHIA 
In 2016, David Hanson created Sophia, a robot that has human characteristics and who 
can copy human gestures and facial expressions. 

Sophia is the world’s first robot citizen who was granted citizenship in Saudi Arabia. 

David Hanson Sophia

Artificial intelligence has become a very important part of our lives today. Devices with AI 
have made lives easier. Before we had to go and physically check whether a restaurant 
or a museum was open or not. But today, we can ask Siri or Alexa and they will tell us 
the update.

Google’s Self-driving car

A robot built in the late 1990s called Kismet can recognise emotions through human body 
language and voice tone.

NEWS FEED
CM
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Match the following.

1.   	 a.  

2.   	 b.  

3.   	 c.  

4.   	 d.  

ACTIVITY TIME

•	 Artificial Intelligence (AI) devices are capable of performing tasks that require 
intelligence. 

•	 John McCarthy is known as the father of AI.
•	 Joseph Weizenbaum developed Eliza in 1966.
•	 Siri, a voice-controlled personal assistant program for apple devices was released 

in 2011. 
•	 Google’s Self-Driving cars use cameras, sensors and artificial intelligence to go from 

one place to another. 
•	 In 2016, David Hanson created Sophia, a robot that has human  

characteristics and who can copy human gestures and facial expressions.

REFRESH

CT
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BROWSE

A 	 Choose the correct option.

	 1. 	� It is the earlier name of the Turing Test.

		  a.   Intimidating Game	 	 b.   Imitation Game	 	 c.   Internet Game�

	 2. 	� He coined the term ‘Artificial Intelligence’.

		  a.   Alan Turing	 	 b.   Arthur Samuels	 	 c.   John McCarthy�

	 3. 	� This program was created by Joseph Weizenbaum.

		  a.   Eliza	 	 b.   Wabot-1	 	 c.   Lisp Program�

	 4. 	� They designed and manufactured Aibo. 

		  a.   Apple	 	 b.   Sony	 	 c.   Amazon�

	 5. 	� It is the name of the robot vacuum cleaner.

		  a.   Roomba	 	 b.   Asimo	 	 c.   Furby�

B 	 Fill in the blanks with the words given below. 

	
WABOT-1    Furby    2011    Sophia    Lisp program

	 1. 	�   is a computer programming language.

	 2. 	� Ichiro Kato created .

	 3. 	� Dave Hampton and Caleb Chung created .

	 4. 	� In , Apple released a voice-controlled  

personal assistant.

	 5. 	� David Hanson created . 
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C 	 Write T for True Statements and F for False Statements. 

	 1. 	� Artificial Intelligence devices are not capable of performing tasks  
that require intelligence.�

	 2. 	� John McCarthy is known as the father of AI.�

	 3. 	� David Hanson created Sophia in 2014.�

	 4. 	� Roomba is an artificially intelligent vacuum cleaner.�

	 5. 	� The name of Apple’s voice assistant is Cortana.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	� Who is known as the ‘Father of AI’?

		

	 2. 	� What was the machine that Alan Turing created that could decode the 
encoded messages?

		

	 3. 	� What is the name of the Virtual Assistant developed by Amazon?

		

	 4. 	� What is the name of the world’s first robot citizen?

		

	 5. 	� This robot is able to communicate with a person and could play piano as well.

		

E 	 Answer the following questions.

	 1. 	� What is Eliza?

	 2. 	� What are some features of Asimo?

	 3. 	� What does Roomba do?
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116 Chapter 9 I Evolution of AI

	 4. 	� What is Siri?

	 5. 	� What does Google’s self-driving car use to go from one place to one another?

Match the following Artificial Intelligence devices with their creator.

1.  

Alan Turing

	 a.  

Sophia

2.  

Ichiro Kato

	 b.  

Furby

3.  

David Hanson

	 c.  

Bombe

4.  

Joseph Weizenbaum

	 d.  

Wabot-1 

5.  

Dave Hampton Caleb Chung

	 e.  

ELIZA

ACTIVITY TIME
CMCT
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117Chapter 9 I Evolution of AI

Using the Internet, search for information on five AI devices. 

On chart paper, paste their pictures and write five sentences about them. You can choose 
to include the AI devices introduced in this chapter or you can select on your own.

LET'S EXPLORE

•	 Discuss the major development in the field of Artificial Intelligence.
•	 Show them the uses of AI with real-life AI enabled devices.
•	 Encourage the students to think of ways they have used AI in their life. 

FOR THE TEACHER

EL CRTE
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PERIODIC ASSESSMENT 4

A.	 Identify the following images and write their names.

	 1.	 	 2.  	 3. 

B.	 Fill in the blanks using the words given below.

BACKDROP     POLYGON     ELIZA     GO BUTTON     PROGRAMMING

	 1.	  is a 2D closed figure made of connected lines.

	 2.	 Scratch is a  language.

	 3.	  is the background of the stage in Scratch.

	 4.	� Joseph Weizenbaum developed , a program that 
can interact in English language.

	 5.	�   is a green flag present in the screen window in 
Scratch.

C.	 Match the following.

	 1.	 Sophia	 a.  Microsoft
	 2.	 Cortana	 b.  To stop a program
	 3.	 WABOT-1	 c.  Allows sprite to draw shapes
	 4.	 Red button	 d.  David Hanson
	 5.	 Pen Block	 e.  Ichiro Kato
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TEST PAPER 2TEST PAPER 2

A.	 Choose the correct option.

	 1.	 Google launched a driverless car in .

		  a.  2009	 	 b.  2014	 	 c.  2019�

	 2.	� Texts that give access to another webpage on clicking are called 
.

		  a.  web browser	 	 b.  hyperlink	 	 c.  IPS�

	 3.	  block is used to add a  .

		  a.  speech bubble	 	 b.  thought bubble	 	 c.  thinking bubble�

	 4.	� In PowerPoint, view mode can be used by clicking on 
 button.

		  a.  Slide Sorter	 	 b.  Reading	 	 c.  Slide Show�

	 5.	  block is used to  the sprite.

		  a.  show	 	 b.  move	 	 c.  hide�

B.	 Fill in the blanks.

	 1.	  blocks are in blue colour.

	 2.	  block allows a Sprite to draw a shape in Scratch.

	 3.	  developed Alexa in 2014

	 4.	  view is the default view in a presentation.

	 5.	  is the unique address of a website.

C.	 Write T for true statements and F for false statements.

	 1.	 A decagon has 9 sides.�

	 2.	 Event block controls sound functions in Scratch.�

	 3.	 Slides cannot be deleted in PowerPoint.�

	 4.	 Computer viruses can delete files from the system.�

	 5.	 Asimo is a robot that has human-like characteristics.�
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D.	 Short answer type questions.

	 1.	 Name any four parts of Microsoft Edge window.

	 2.	 What is the title slide in PowerPoint?

	 3.	 What is the command to draw a circle in Scratch?

	 4.	 Define the term artificial intelligence devices.

	 5.	 What is meant by the event block in Scratch?

E.	 Long answer type questions.

	 1.	 What is a website? How can you access it using a search engine?

	 2.	 Name any five parts of the Scratch window and define them.

	 3.	 What is Polygon? How can you draw a polygon using a repeat command?

	 4.	 Write a note on the Turing Test.

	 5.	 What are the two methods to view a presentation? Explain.
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121Project

A.	 Create the given document in MS Word 2016.

Windows
1.	 An operating system makes sure that the computer system is working 

smoothly.
2.	 Windows is an operating system based on the GUI provided by Microsoft.
3.	 It has many versions such as Windows XP, Windows 10 and Windows 11.
4.	 Windows 10 is the most popular version.
5.	 Windows 10 was launched in 2015.

	 Now, edit the document and make these changes:

	 •	 Change the font style of the heading “Windows” to Times New Roman.

	 •	 Change the font size of the heading to 20 point.

	 •	 Center align the heading.

	 •	 Change font case of the heading to UPPERCASE.

	 •	 Change font colour for point 1 to red.

	 •	 Highlight “GUI” in point 2.

	 •	 Bold “Windows 10” everywhere.

	 •	 Change numbering to bullets.

B.	 Draw the following shapes in Scratch.

	 1.  	 2. 

	 3.  	 4. 
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C.	 Create the following presentation on MS PowerPoint 2016.

Slide 1 Slide 2

Slide 3 Slide 4

D.	 Create the following in Scratch using the given coding.
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(Sample paper)

LOGICAL REASONING

1.	 Choose the correct option to complete the series.

165 180 195 210 ?

	 a.  220 	 b.  225 	 c.  235 	 d.  250

2.	 Which of the following options shows the correct mirror image of the word 
‘READING’.

	 a.  GNIDAER
	 b. 

GNIDAER

	 c.  READINe
	 d.  rE

A
DI Ne

3.	 If in a code language, POET is coded as 6789, WORD is coded as 1754, then how is 
POWER coded?

	 a.  67185	 b.  76485	 c.  45678		  d.  95418

COMPUTERS AND INFORMATION TECHNOLOGY

4.	 E-mail can be used for .

	 a.  video calling

	 b.  counting steps

	 c.  creating presentation

	 d.  chatting

5.	 In MS-Word 2016,  buttons are used for .

	 a.  text alignment	 b.  font colour	 c.  text effect	 d.  font case

6.	 Select the software that can be used for making presentations.

	 a.  	 b.  	 c.  	 d. 

NATIONAL CYBER OLYMPIADNATIONAL CYBERNATIONAL CYBER  OLYMPIADOLYMPIAD
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124 National Cyber Olympiad

7.	 This key takes a snapshot of the screen and saves it to the clipboard. Identify  
the key.

	 a.  	 b.  	 c.  	 d. 

8.	 Choose the popular application software that can be used for audio and video 
calling.

	 a.        b.        c.        d. 

ACHIEVERS SECTION

9.	 The given pop-up menu will appear when we right click on a  
desktop icon in Windows 10. Which of the following desktop  
icon is this?

	 a.      b.      c.      d. 

10.	 Which of the following type of network is shown in the given image?

	 a.  LAN	 b.  PAN	 c.  WAN	 d.  CAN
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